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The specifications and information regarding the products in this manual are subject to change without 

notice. All information, examples and recommendations in this manual are believed to be accurate but are 

represented without warranty of any kind, express or implied. Users are fully responsible for their application 

of any products. 

See the product page at https://www.quantumdata.com/m42d.html for the most up-to-date User Guide. 

 

Support 

For further support on your M42d Instrument, contact Teledyne LeCroy support via 

https://www.quantumdata.com/support.html. 

Please provide the following information in your message to the support team: 

▪ Your location 

▪ ATP Software Version (if applicable) 

▪ Device Model Number 

▪ Device Serial Number 

▪ Firmware Version Installed 

▪ Instrument Information Report .txt file (if available) 

Note: All of the device information can be found within the Instrument Information Report .txt file, so 

these can be substituted with the full Information Report. Instructions for accessing and saving the 

Instrument Information Report can be found in Section 2.2 

  

https://www.quantumdata.com/m42d.html
https://www.quantumdata.com/support.html
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1 Getting Started with the M42d 

 About the M42d DisplayPort 80Gbps Video Analyzer/Generator 

This chapter provides an overview of features of the M42d DisplayPort 80Gbps Video Analyzer/Generator. 

The M42d is a compact, versatile test instrument offering entry level functional testing that can be extended 

through software licenses to full compliance testers with sophisticated analysis and diagnostic capabilities. 

The M42d supports video pattern testing and audio testing of DP 2.0 capable displays with 1, 2, or 4 lanes at 

20 Gb/s link rates per lane, for an 80 Gbps max link rate. It is also backward compatible with DP 1.4 and 

includes all functionality of the M41d. It is equipped with two (2) Tx ports and two (2) Rx ports—one each for 

standard DisplayPort and USB-C with DP alt mode support. Only one of the Tx ports and one of the Rx ports 

can be active at any one time. 

The M42d is operated through the Advanced Test Platform (ATP) Manager. The ATP Manager is a GUI 

application that can run either on a Windows host PC or an external display connected to the HDMI port on 

the back of the M42d. Chapter 2 is dedicated entirely to the ATP Manager.  

 

Key Features of the M42d 80G Video Analyzer/Generator 

Note: Certain features and functions of the M42d require licensing. More information on licensing can be 

found in Chapter 2 (Applying Licenses) or Appendix A: Licenses.  

▪ Equipped with both DP standard and USB-C ports for Tx and Rx functions 

▪ Test DP sources 10Gb/s, 13.5Gb/s, and 20Gb/s lane rates at the new 128b/132b line coding 

▪ View incoming video and metadata—including DSC compressed--from a source device 

▪ Capture and decode incoming video, protocol, and control packets including Display Stream 

Compression (DSC) 

▪ Run functional tests on displays and monitors at UHBR lane rates with large format and test pattern 

library 

▪ Configure link training parameters to test display’s handling of link training 

▪ Generate Display Stream Compression (DSC), select patterns and configure slices and video 

parameters 
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▪ View and edit EDID and DPCD registers 

▪ Monitor Aux Channel transactions while emulating a DP 1.4 or DP 2.0 source or sink 

▪ Passively monitor the Main Link and Aux Channel between a source & display at UHBR lane rates 

▪ Panel Replay testing for sources and sinks 

▪ LTTPR device emulation in Transparent mode for testing LTTPR-capable source devices at 8b/10b 

line code for lane rates up to HBR3 (support for LTTPR in non-transparent mode for 128b/132b at 

UHBR rates is coming soon) 

▪ View Power Delivery (PD) negotiations for USB-C DP Alt Mode 

▪ DP 2.0 Link Layer compliance tests on source devices up to 13.5Gb/s per lane 

▪ 1.4 Link Layer compliance tests on sources and sinks up to 8.1Gb/s per lane 

▪ Run DP 1.4 Forward Error Correction (FEC) and Display Stream Compression (DSC) compliance 

tests for sources and sinks 

▪ Run HDCP 2.3 compliance tests on DisplayPort sources, sinks and branch devices 

▪ Run audio tests using programmable LPCM sine wave audio tones 

▪ Run tests on embedded DisplayPort (eDP) 1.4b sources and panels using fast link training, ALPM & 

backlight control 

 What makes the M42d 80Gbps Video Analyzer/Generator unique? 

The Teledyne LeCroy quantumdata M42d Video Analyzer/Generator provides an unprecedented 

combination of functional and compliance testing for video, audio and protocol of DisplayPort 2.0 and 

DisplayPort 1.4. The M42d supports legacy DisplayPort lane rates of 1.62, 2.7, 5.4, 8.1 Gb/s and the new 

DP 2.0 higher speed lane rates and new line coding— 128b/132b—of 10.0, 13.5, and 20.0Gb/s data rates 

up to 4 lanes.  

The protocol analyzer provides a snapshot status view and deep analysis using captures of incoming 

DisplayPort 2.0 (and DP 1.4) streams from source devices including DSC/FEC compressed streams.  

The M42d’s video generator can be used for testing displays, USB-C adapters, extenders, etc. The video 

generator offers a large library of standard video timings and test patterns necessary for testing next 

generation high resolution displays.  

The M42d supports a full suite of DP 1.4 link layer, forward error correction (FEC) and Display Stream 

Compression (DSC) compliance tests for both sources and sinks. Support for Compliance Tests for DP 2.0 

are being added on a rolling basis. See the compliance tab on the M42d product page 

(https://www.quantumdata.com/m42d.html) for currently supported compliance tests.  

The Passive Probe feature, based on Teledyne LeCroy's cutting-edge T.A.P.4™ technology, enables full 

monitoring of the DisplayPort Main Link and the Aux Channel between two DisplayPort devices up to 20 

Gb/s. 

  

https://www.quantumdata.com/m42d.html
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 Scope of this User Guide 

This user guide documents the operation of the M42d 80 Gbps Video Analyzer/Generator. It is intended to 

be used with the M42d Quick Start Guide. 

The user guide describes the features and functions of the M42d 80 Gbps Video Analyzer/Generator as 

operated either through the standalone PC application (i.e. the ATP GUI Manager) or with the ATP GUI 

Manager running on the M42d itself and displayed on an external monitor connected to the HDMI port on the 

back of the M42d. The screen shots used are usually from the most current release of the ATP GUI 

Manager running on a host PC. 

High-level tasks described in this chapter 

▪ Getting started procedures 

▪ Provisioning the IP address of the M42d 

▪ Installing the M42d ATP GUI Manager on a PC 

▪ Establishing an IP session between an M42d and the host PC running the ATP GUI Manager 

▪ Connecting the DisplayPort source or sink devices under test to the M42d 

What is not covered in this user guide 

The M42d supports a full suite of DP 1.4 and 2.0 link layer, Forward Error Correction (FEC) and Display 

Stream Compression (DSC) compliance tests for both sources and sinks. Support for compliance tests for 

DP 2.0 are being added on a rolling bases; however, please refer to the M42d product page for updates on 

these functionalities. Note: These compliance tests are not covered in this user guide.  

 Revisions to this user guide 

This is the first version of this user guide. Any additions or changes in future versions will be noted in this 

section. 

Note: please be sure to check the quantumdata website and M42d product page for updates to this User 

Guide https://www.quantumdata.com/m42d.html.   

 What kinds of data does the M42d 80 Gbps Video Analyzer/Generator allow 

you to view? 

By providing visibility into the DisplayPort protocol, and the underlying protocol, video and secondary data 

packets blocs, as well as DPCD data during link training, the M42d Video Analyzer/Generator enables you 

to detect changes and identify anomalies in either the DP 1.4 or 2.0 signal. The following is a list of the data 

types you can view (currently): 

▪ Main Link 

• K Character 

• Control data 

• Video data 

https://www.quantumdata.com/m42d.html
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• Audio data 

• Secondary Data Packets 

▪ Aux Channel Read/Write transactions, including: 

• Native DisplayPort aux transactions for capabilities discovery 

• Link Training transactions 

• Multi-Stream Transport Sideband Messages 

• Other DPCD 

• EDID 

• HDCP authentication transactions 

▪ Error data 

▪ Markers 

 What is in the M42d shipping box? 

When a Teledyne LeCroy quantumdata M42d 80G Video Analyzer/Generator is shipped, it will contain the 

following additional items: 

▪ AC power line cord 

▪ CE mark declaration 

▪ DisplayPort to DisplayPort cable 

▪ USB-C cable (unmarked) 

▪ USB-C cable (marked) 

▪ CATC Micro-D cable assembly 

▪ Ethernet cable 

▪ Mouse 

▪ Quick Start Guide 

Positioning/Orientation 

The M42d can be positioned either flat or upright, pictured here: 

 

 

 

 

  

Flat positioning 
Upright  

positioning 
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 Getting the M42d up and running 

Use the following procedures to get your M42d up and running. 

1. Remove the M42d from the shipping box and lay it flat or upright on your desktop or benchtop. 

2. Connect the M42d power cable (provided) to a suitable outlet (110-240V 50/60Hz). The power socket is 

on the back of the M42d as shown below. 

 

3. Connect an external HDMI monitor to the HDMI connector on the back of the M42d; labeled “External 

Monitor” at the location indicated below. 

  

To Ext Display 

Power 
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The setup is depicted below. 

 

 

4. Connect a mouse to one of the USB ports on the front or back of the M42d as shown below. 

5. Optionally connect a keyboard to one of the other USB ports on the front or the back of the M42d. You 

can also use the virtual keyboards that present themselves in the ATP Manager. 

 

External 
display for 
ATP 
Manager 
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Power up the M42d via the power button on the front of the M42d. 

 

Notes: Regarding Power Button color: 

▪ Solid Red = Powered down/standby 

▪ Solid Green = Booted without network connectivity 

▪ Solid Blue = Booted with network connectivity 

▪ Solid Yellow = The front button is being actively pressed in 

▪ Flashing Yellow = Instrument is powering up 

▪ Flashing Green = Instrument is nearly done powering up (FPGA is ready, firmware still loading) 

▪ Flashing Red = Error 

 

The ATP Manager application will appear on the external display as shown below. 

 

Power 



M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 14  July 18, 2021 

 

Adjusting M42d Internal Fan Speed 

Once the hardware is set up with an external display connected directly, you may optionally adjust the 

internal fan on the M42d unit from its default Full Speed setting to the Standard Speed. 

Full Speed is enabled by default in order to meet the specification of maximum operating ambient 

temperature of 40°C. Full Speed is necessary for operating at ambient temperature between 30°C and 

40°C. If you will be operating the unit at less than 30°C (86°F), you may safely change the fan to Standard 

Speed, which is quieter than the Full Speed setting. 

Note: This procedure needs to be done on the M42d instrument itself using a display connected to the M42d 

with a keyboard connected to the USB-A port of the instrument.  

The procedure for adjusting fan speed is as follows: 

1. If not already off, power down the unit by pressing the power button once. 

2. Once completely shut down (power button light is red), power the unit on by pressing the power button 

again. 

3. While booting up, press the DEL key repeatedly to place into BIOS mode. 

4. Once in BIOS mode, use the right arrow to select Advanced tab. 

5. Use the down arrow to select NCT6106D HW Monitor and press Enter. 

6. Press Enter again to select Fan Speed Control Mode 

7. Use up/down arrow keys to select Standard and press Enter 

8. Press F4 key to prompt the Save & Exit Setup dialog box. 

9. Press Enter to save configuration and exit. 

The device will automatically reboot normally with the lower fan speed setting. 

 

  



M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 15  July 18, 2021 

 

Connecting a DisplayPort Source Device Under Test 

To connect your source DUT to the M42d: 

Connect the source device under test to the M42d DisplayPort In/Rx port as shown below. Note that you can 

connect either through the full-size standard DP port or the USB-C DP Alt Mode port depending on the lane 

rate (USB-C port shown in the example below). 

 

The full test setup up is shown below with the ATP Manager running on the M42d with the ATP Manager 

GUI on the external display. The sample screen show shows an DisplayPort analysis screen. 
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Connecting a DisplayPort Sink Device Under Test 

To connect your sink DUT to the M42d: 

Connect the sink device under test to the M42d DisplayPort Out/Tx port as shown below. Note that you can 

connect either through the full size standard DP port or the USB-C DP Alt Mode port depending on the lane 

rate (example shows connection to USB-C port). 

 

The full test setup up is shown below. This example uses the ATP Manager installed on a host PC. 

 

Connecting a DisplayPort Source and Sink Device for Passive Monitoring 

Passive Monitoring or Passive Probing is a licensed feature of the M42d as well. Full instructions for the 

connections and Passive Monitoring itself are provided in Chapter 7 Passive Monitoring  
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 Connectors and Controls 

The table below describes the M42d connectors and controls. 

M42d Configurations Information / Function 

Protocol Analyzer in M42d 

 

 

 

 

 

 

 

 

 

 

 

Front panel: 
▪ A – USB-C Out/Tx port for all HBR and UHBR 

data rates up to 20 Gbps. 
▪ B – USB-C In/Rx port for all HBR and UHBR data 

rates up to 20 Gbps. 
▪ C – DP Out/Tx port for RBR, HBR, HBR3, and 

UHBR10 (10G data rates) 
▪ D – DP In/Rx port for RBR, HBR, HBR3, and 

UHBR10 (10G data rates) 
▪ E – USB ports (2) used for connecting a mouse 

and keyboard. 
▪ F – Knob for turning up or down the volume for 

the internal speaker. 
▪ G – Power button; press and release. 
▪ H – eDP block for Backlight Control (See Note 

Below). 
 
 
Back panel: 
▪ I – Power plug (110-220VAC 50/60Hz) 
▪ J - HDMI – Admin port for connecting external 

HDMI UHD display for M42d ATP Manager. 
▪ K - DisplayPort – Not recommended for use 

currently. 
▪ L - USB/USB-C (2 ea.) – For mouse & keyboard. 
▪ M - RJ45 (2) - E1 Network for connecting host 

PC running ATP Mgr. E2 Aux – Future. 
▪ N - DVI – Possible future use. 
▪ O - RS-232 (2) – Possible future use. 
▪ P - Audio (2) – Possible future use. 
▪ Q – CrossSync™ for TRIG IN/OUT – Future. 
▪ R - RCA SPDIF In/Out  

 

Note: The eDP header block provides PWM signal used for controlling the backlight of some eDP displays. 

The pinout and functions are shown on the next page. 

  

A 

E 

H 

K 

J L 

F 

M 

N O P 

Q R I 

B 

G 

C D 
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eDP Pin Configurations 

1. BL_Enable (Possible Future Rx input) 
2. BL_Enable (Tx Output) 
3. BL_PWM_DIM (Possible Future RX input) 
4. BL_PWM_DIM (TX Output) 
5. Ground 
6. Ground 

 

 

 

 

 

eDP is covered in Chapter 10 Embedded DisplayPort. 

Important Notes Using External Monitor for ATP Manager 

Note 1: Selection of external monitor 

Due to HDCP content protection requirements, you will have to use an HDCP 2.2 or 2.3-enabled 

external monitor to view HDCP protected content in the ATP Manager GUI. We have qualified the 

following displays: 

• Dell UltraSharp 27 inch Monitor Model U2718Q.  

• Dell UltraSharp 27 inch 4K Monitor Model U2720Q. 

• ASUS 28" 4K UHD Monitor Model VP28U. 

• ViewSonic 27" 4K UHD Monitor Model VX2776-4K-MHD. 

• Other 4K HDCP 2.3 displays may work as well. (for most up-to-date list, refer to the latest revision of 

the User Guide on the M42d product page https://www.quantumdata.com/m42d.html.  

 

Note 2: Changing the ATP Manager GUI Display Resolution 

You can change the resolution that the ATP Manager GUI is display at on the connected monitor using 

the Mint Linux utilities. Follow these steps: 

Step 1: Click on the lower right corner icon to access Shutdown menu. Under GUI Application click on 

the Close button. The ATP Manager GUI will close. 

Step 2: Once the ATP Manager is shutdown, click on the Mint icon (green M) on the lower left corner of 

the monitor to access the Mint Linux Controls. 

Step 3: Select the Settings primary menu on the left and then on the right select Display 

Configuration secondary menu. The Display Configuration menu appears. 

Step 4: Set the resolution to 1080p using the Resolution pull-down menu. The resolution should 

change and persist through a reboot. 

  

https://www.quantumdata.com/m42d.html
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2 ATP Manager GUI Application 

 Operating the ATP Manager from an external display 

The M42d is operated through the Advanced Test Platform (ATP) Manager. The ATP Manager is a GUI 

application that can run either on a Windows host PC or on an external display connected to the HDMI 

port on the back of the M42d.  

When operating from an external display, a mouse (provided) is required and a keyboard is optional but 

recommended. In this case of the external display, the ATP Manager is running on the M42d itself, but the 

ATP Manager GUI is displayed on the external monitor. This operational scenario is shown below. 

 

ATP Manager Running on External Display (Source Test Example) 
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 Operating the ATP Manager on a host PC 

You can operate the M42d from the ATP Manager application installed on a host PC. The connection can 

either be direct, or over a LAN. It is suggested that you consult with your local IT or network administrator for 

address assignment policies if using your local area network. 

You will have to first download and install the ATP Manager GUI application on your Windows PC. You will 

then need to connect your PC to the M42d over an Ethernet IP connection. These procedures are provided 

below. 

Please note: You will have to have completed the procedures in the section above (1.8 Getting the M42d 

Up and Running) in order to complete the following steps. 

Installing and Connecting the M42d ATP Manager GUI Application 

This procedure describes how to setup the ATP Manager application on your host PC and connect to the 

M42d. 

1. Download the ATP Manager GUI application from the quantumdata downloads page: 

http://www.quantumdata.com/downloads.html. 

 

Double click on ATP Manager and follow the installation prompts to install the ATP Manager on your 

Windows PC. 

Download 

Link 

http://www.quantumdata.com/downloads.html
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2. After installation completes, run the new ATP Manager. It should be available in the Start Menu under All 

Programs → Quantum Data, and also from an icon on your host PC Desktop. 

Note: Verify that the version number in the title bar matches the version on the website. 

3. Connect your PC to the M42d using an Ethernet cable. The connection is made to the Rj45 jack on the 

back of the M42d labeled E1 to Network as shown below. 

 

The Ethernet IP connection from the host PC to the M42d can be accomplished through your corporate 

network or you can connect directly. Both scenarios are depicted below. 

 
PC Running ATP Manager with Ethernet Direct Connection 

E1 to Network 
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PC Running ATP Manager w/ Ethernet Connection thru Corporate LAN 

 

4. Set the IP address of the M42d from the Other page under the Control window of the ATP Manager 

GUI. Select the Instrument Network Settings icon. A dialog box appears enabling you to set DHCP or 

specify an IP address. Sample screen shots of these windows are shown below. 

 

1 

    2 
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Note: Be sure to use an IP address that is compatible with your corporate LAN or your PC if you are 

connecting directly. 

 

5. The instrument will automatically power cycle upon applying changes to the Network Settings.  

 

Note: If using DHCP for IP address assignment, check for the resulting IP address at the bottom left of 

the embedded GUI after rebooting, as shown below. 

 

  

Power 
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6. Add your M42d to the ATP Manager application using the green + Add icon or the + Add item on the 

Instrument pull-down menu within the Navigator, identified below.  

 

The Add Instrument dialog appears enabling you to enter the name and IP information for the M42d 

that you are trying to connect to (below). 

 

7. Enter the name (any suitable name) and IP address (obtained in step 4) of the M42d that you want to 

connect to in the Add Instrument dialog box (above) and click on the Add activation button. 

  

2 

1 
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You will see a series of messages on a dialog boxes describing the progress. One example is shown 

below:  

 

The M42d with the IP address you entered appears on the list in the ATP Navigator panel (below). The 

ATP Manager application will automatically connect to the M42d once you add the M42d to the 

application. 

8. (If not already connected) Connect to the M42d using the Connect button or the Connect item on the 

right click menu as shown in the screen below. 

 

A dialog box appears indicating that a connection is in progress. 

  

    2 

    1 
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Saving the Instrument Information Report 

Once the connection is made the information about the connected M42d is available via the Information 

button as shown below. 

 

The information is then displayed in a separate window. The information on the Instrument Information 

window tells you the firmware and hardware release and version information as well as what options you 

have. This report will be needed if you contact Teledyne LeCroy technical support for any operational 

questions or issues. The procedure for saving the information report is described on the next page. 
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You can save this instrument information report as a .txt file. This is necessary when contacting Teledyne 

PSG Support, as a current version of the report is needed for general support purposes. 

Save the Instrument Information Report by selecting the SAVE TO FILE button at the bottom left of the 

report window, as shown below. 

 

Enter the desired file name and folder directory, and the information report will be saved as a .txt file. 
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 ATP Manager Home Screen and Navigator 

The previous sections briefly showed the ATP Manager GUI, but this section will cover the basics of the 

Interface in more detail, specifically the Home Screen and Navigator. 

Home 

When first opening the ATP Manager, you will see the Home screen. This interface has 4 tabs: 

▪ Control 

▪ Compliance 

▪ Editors 

▪ Other 

Each of these tabs has its own apps within them. Aside from Compliance, these will all be covered in detail 

throughout this User Guide. An example of the home screen on a remote PC ATP Manager GUI is shown 

below. 

 

Notice the Navigator panel is side by side with the home screen (labeled Apps). Either can be minimized or 

restored using the buttons at the top right of the respective panel. The example below has the Navigator 

minimized. 
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The screenshot below is of the embedded GUI on the M42d instrument itself. Note the main difference being 

that the Navigator and Home are separated in this GUI. 

In order to access the Navigator, click the Navigator icon at the bottom left of the screen. Additionally, you 

can use the BACK button to navigate back to previous utilities, or click the power button in the bottom 

right to shut down or reboot the device. 
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Navigator 

The Navigator is a feature-rich utility in the ATP Manager that allows for data portability and customization 

with the M42d 80G Video Analyzer/Generator. 

The Navigator has a sidebar, as seen in the table below, with several options. This subsection will cover a 

few of these options now, while others are detailed in later chapters. 

Navigator Sidebar 

Sidebar Button Description 

 

Captures Access the directory containing Captures on the device or remote PC. 

Compliance Access the directory containing Compliance Test selections and results  

ACA Access the directory containing Aux Channel Analysis data and Filters 

EDID/DPCD Access the directory containing saved EDID configurations and DPCD 

registers 

Formats Access the directory containing saved Formats and Format Lists 

Images Access the directory containing Image Patterns and Image Lists  

Instruments List of connected devices. Covered in Section 2.2 Installing and 

Connecting the M42d 

Other Access Saved Reports 

Help Access the help/about menu 

Import Import a file onto a remote PC ATP Manager (remote manager only) 

Exit Quit the ATP Manager Application 

 

The Navigator allows you to Import and Export files onto the M42d instrument itself or the remote PC 

running the ATP Manager GUI. These features enable you to disseminate or receive data and files to/from 

colleagues, subject matter experts, or Teledyne LeCroy technical support. 

The Transfer tool within certain tabs is only available on the Remote ATP Manager GUI. The transfer tool 

allows you to transfer data and files between the remote PC and the M42d instrument. This can be useful for 

backing up files to both devices or for remote access of tests or analyses run using the embedded GUI ATP 

Manager on the M42d device. 

Examples of file import and export as well as transfer are covered in 6.6 Importing, Exporting, and 

Transferring Capture Files as well as 7.5 Importing, Exporting, and Transferring ACA Data 
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 Accessing Device Settings and Information 

Note: Any selections in the Other panel not explained here will be covered later on in this User Guide. 

Applying Licenses 

Many of the features of the M42d require a specific license to operate. This subsection will demonstrate 

applying a license.  

A list of all available licenses is located in Appendix A: Licenses. 

Note: To obtain a license for the M42d, contact Teledyne Support, accessible at 

http://quantumdata.com/support.html 

 

To apply a license: 

1. Upload the license file (.lic) using the Navigator by clicking Instruments, then selecting Licenses and 

clicking Apply ATP License. Alternatively, you can access this by selecting the Other tab on the GUI 

home screen and selecting Apply ATP License. Both are shown below. 

Note: As the license file will likely be saved to your PC, it is recommended to use the remote host ATP 

Manager for this function. All screenshots are based on this GUI, though they are both similar. 

Using the Navigator: 

 

http://quantumdata.com/support.html


M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 32  July 18, 2021 

 

Using the GUI: 

 

2. A file explorer will appear, as shown below. Navigate to the correct directory of the previously 

downloaded license, select the .lic file, and click Open. 

 

3. A confirmation will appear, and you must reboot the device for the changes to take effect. 
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Verifying Current Licenses 

Upon reboot, you may wish to confirm that the correct license was applied. Use the following procedure to 

check the licenses that are currently applied to your M42d instrument. 

1. Using either the embedded M42d GUI or Remote Host PC ATP Manager, open the Navigator. 

2. Select the Instruments tab. 

3. Choose the instrument that you are looking up and select Information on the left-hand side bar. 

The Remote ATP Manager will automatically connect to the specified device, if not already connected.  
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The About window will appear, which has various information about the device, and has the Licensed 

Features listed toward the bottom of the report, as demonstrated below. 

Instructions for saving the Instrument Information Report can be found in Section 2.2. This saved 

Information Report is necessary when contacting Teledyne LeCroy PSG Support, as a current version of the 

report is needed for creating licenses. 
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Setting the Instrument date and time 

This procedure describes how to set a M42d’s data and time. The procedure assumes that you have 

connected to an M42d through the external ATP Manager. 

To set the date and time of the M42d: 

From the Other page (Page 4) of the Apps Window select Set Instrument Date/Time. 

 

The Select Date/Time dialog box appears as shown below: 

Set the month and date and time by selecting from the Calendar and time dials. 

 

  

2 

  1 
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 Upgrading ATP Manager 

This section provides information about upgrading your M42d and M42d ATP Manager. Detailed procedures 

are not provided in this document. Please be sure to refer to the Release Notes for a specific release for 

detailed upgrade instructions. 

Teledyne LeCroy periodically provides maintenance release of software and firmware. The most recent 

versions are available on the quantumdata downloads page http://www.quantumdata.com/downloads.html. 

 

Two software packages are available for upgrading the M42d: 

The firmware and gateware package for the M42d instrument. This is a Debian software package for 

installation in the Linux-based instrument. (The file extension is .deb.) This package also includes the 

embedded ATP Manager that will be installed. 

Windows-based ATP Manager. This is the ATP Manager GUI that can be used to control the M42d 

instrument from a Windows PC. This download is discussed previously in Section 2.2 – Operating the ATP 

Manager on a host PC  

Notes: 

You must upgrade the Windows-based ATP manger every time you upgrade the firmware/software on the 

unit. Upgrade the ATP Manager first, and then upgrade the M42d application firmware as indicated in the 

release notes. 

Please be sure to refer to the Release Notes for the specific release for detailed upgrade 

instructions. 

Download Links 

http://www.quantumdata.com/downloads.html
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 VNC Remote Connection  

Sections 2.1 and 2.2 discussed controlling the M42d device either directly using an external monitor, or 

remotely using the ATP Manager application on a remote host PC. However, the M42d 80G Video 

Analayzer/Generator does come with another built-in option for controlling the device remotely.  

The instruments come with TightVNC Server installed and enable the user to access the embedded GUI of 

the instrument remotely as an alternative to using the ATP Remote Manager. The main advantage of this is 

to utilize features that are modified or inaccessible while using a remote host ATP Manager.  

Installing TightVNC Viewer and Connecting to the Device 

TightVNC Viewer for windows is available for free download at https://tightvnc.com/download.php. 

Navigate to this page on the remote PC that you would like to control the M42d device from, and install the 

compatible software package. 

Note: TightVNC comes pre-installed on the M42d device and the server runs automatically on startup, so 

nothing further needs to be done on the instrument other than powering the device on. 

Once TightVNC is installed on the remote computer, open the TightVNC Viewer application from the 

installation directory folder. 

 

 

  

https://tightvnc.com/download.php
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Enter the device’s IP address in the Remote Host field, and click Connect. Instructions for locating the 

device’s IP address are in 2.2 Operating the ATP Manager on a Host PC. 

 

The default password for the instrument is elocution, though this can be modified on the TightVNC Server 

application on the M42d device itself.  

With the VNC Viewer, you can operate the instrument’s embedded GUI to access certain features 

unavailable on a remote host PC ATP Manager GUI.  
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3 Generator 

 Overview 

This section provides information for using the M42d video generator function. 

To access this, select the Generator application icon from the home screen.   

The Generator screen has a status area on the top of its panel, pictured below. 

 

 

 

 

 

The status area provides the following information: 

Generator Status Area (Top) 

Number Item Description 

1 Mode Multi-stream (Multi-Stream Transport) or Single-stream (SST) 

Transport 

2 DSC Indicates whether Display Stream Compression is currently 

on or off 

3 FMT The currently active format (selected resolution) 

4 IMG The currently active image (selected test pattern) 

5 Resolution, scan, and color Resolution, scan type, and colorimetry type of active format. 

6 P-Rate The pixel clock rate of the selected timing. 

7 F-Rate The frame or vertical refresh rate of the selected timing. 

8 H-Rate The horizontal refresh rate of the selected timing. 

9 Video Identification Code (VIC) The VIC code is shown in parentheses, followed by the 

resolution, frame rate, and aspect ratio of the active format. 
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 Selecting DisplayPort Video Format 

Use the following procedures to select a video resolution (format). To access the formats menu, select the 

Format tab at the top of the Generator application in the M42d GUI Manager.  

 

You can select formats (timings) from either the M42d 80G Video Analyzer/Generator’s format library, from 

the CTA or VESA parameter filters, or from a reduced subset of formats. You can select a format in one of 

four ways, which are all covered in this section.  

▪ Select using CTA or VESA smart filters 

▪ Select from the entire library list of formats 

▪ Select from a custom list you have created using the Format List Editor 

▪ Select from a list of formats configured from the EDID of the connected display 

Once you’ve selected the desired format, you can adjust the settings of this format, which is covered at the 

end of this section. 

Selecting format using the CTA or VESA Smart Filtering button 

From the Generator, click the Format tab. 

Select either the CTA or VESA subtab underneath the Format tab. The smart filtering screen enables you to 

select CTA or VESA formats through filtering of various video parameters such as Resolution, Vtotal, Frame 

Rate, and Aspect Ratio.  
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In the previous screenshot, Left to Right selection is enabled (circled at bottom of screen). This will show 

available formats (on the right) that meet the filtering criteria as you narrow down the specified parameters in 

the following order: 

1. Resolution 

2. Vtotal 

3. Frame Rate 

4. Aspect Ratio 

5. Box 

Instead of Left to Right, you can also select Arbitrary, which enables you to specify filtering criteria in any 

order. Refer to the example below.  

In this example, we are using the VESA smart filter and selecting a Frame Rate of 30 Hz and a 16:9 Aspect 

Ratio. A list of formats on the righthand side of the screen shows the formats that match these first two 

criteria selected. You may select one of these formats now or continue filtering by Resolution and Type. 

Available 

Formats 
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Note: To unselect any of the selected filtering criteria, click Clear Selection at the bottom of the window 
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Selecting format from Library List 

Use the following procedures to select a video resolution (format) using the Library List method. 

From the Format tab of the Generator app, click the Folder subtab. The directory whose formats are being 

displayed is listed in the lower panel.  Typically, this would be the 

Standard directory where the M42d’s format list is stored. The default path is the Standard path. 

A list of DP, HDMI, or DVI formats will appear as shown in the example below. 

 

The highlighted format is the format that is active. You can also determine this from the status information at 

the top of the panel. Alternatively, you can click on the Star icon in the bottom right of the panel, and 

the window will scroll to the currently selected format. 

Select a format by clicking on it. Note that you can browse for a format using the scroll bar on the right. You 

can also search for a format using a test strings on the Find Format dialog box. 

Click on the Find button on the lower portion of the Format panel. 
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The Find Format dialog box appears as shown below. Enter a string in the Search Text field to find a 

format. You can specify either Starts with or Contains using the radio buttons and you select the Case 

Sensitive check box to indicate case sensitivity in your text. Click on the OK button when you have located 

the format. 

In this screenshot example, the text “CVT” has returned 180 possible matches. 

 

Selecting format using custom Lists 

You can create a custom list of formats using the Format Editor (covered in section 4.5, under the Tools 

tab). This allows you to quickly select from an abbreviated list of your preferred formats. To access your 

list(s), Click the Lists subtab underneath the Format tab. The screen below is what you will see; notice that 

before selecting your list, you’ll get a blank screen and the bottom taskbar will read “<No Lists Selected>” 

 

You can open up and activate any custom Format Lists you have previously defined using the SELECT icon 

(arrow above). A dialog box will appear enabling you to select a custom format list or lists. 
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You can select any or all of the custom Format Lists. The example above shows two custom lists, but you 

can make as many as you’d like. Note that selecting multiple Lists will display all of them in the Format 

selection window. The screenshot below shows a single list selected. The name of the list or lists will appear 

in the bottom taskbar. 

 

Generating format from EDID 

The final subtab under Format is the EDID smart activation panel. Click on this button to configure the list of 

formats in accordance with the EDID for the connected display. The screenshot below shows the EDID 

panel and the READ EDID AND GENERATE FORMATS button, which will present a listing of the preferred 

formats for the connected DUT. 
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Configuring the format Settings 

Use the following procedures to configure the format settings. The Settings dialog box enables you to 

configure the Color Space, Range, and Bits per Component. 

Specify the format settings by clicking on the Settings button on the lower center of the panel.

 

The Settings dialog box appears as shown below. Select the Color Space, Range, and Bits per Component 

from the Format Settings dialog box in accordance with your requirements. 

 

 

Format Settings 

Parameter Description Options 

Color Space Colorimetry and video pixel 

encoding settings. 

• RGB – Uses 4:4:4 sampling. 

• YCbCr – Uses either 4:4:4, 4:2:2 sampling. 

• BT2020RGB 

• BT2020 cYCC 

• BT2020 YCC 
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Format Settings 

Parameter Description Options 

Quantization Range These values are 

described in CEA-861E. 

They pertain to the number 

of levels for RGB and 

YCbCr mode. 

• Limited – Use for CEA formats. Please refer 

to the specification section on Video 

Quantization Ranges for more details.  

• Shoot – for testing the 

undershoot/overshoot signal code margins. 

• Full - Use for PC formats. Please refer to 

the specification section on Video 

Quantization Ranges for more details. 

Bits per Component Color depth per 

component. 

• 6 – Six (6) bit per component (24 bit per 

pixel) color depth. 

• 8 – Eight (8) bit per component (24 bit per 

pixel) color depth.  

• 10 – Ten (10) bit per component (30 bit per 

pixel) color depth; deep color. 

• 12 – Twelve (12) bit per component (36 bit 

per pixel) color depth; deep color. 

• 16 – Sixteen (16) bit per component (48 bit 

per pixel) color depth; deep color. 
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 Pattern 

Use these procedures to select a test pattern and configure its settings. Click on the Pattern tab at the top of 

the Generator app to access the list of test patterns. You can select a pattern either from the Library List 

(Folder subtab) or a custom list that you create. 

Selecting a test Pattern from the Library List Folder 

Upon clicking the Pattern tab, a list of patterns will appear. The directory of this Library List is located at the 

bottom of the window, as shown below. By default, the path is set to Standard, which will display the entire 

test pattern library. 

 

Select a pattern from the list by clicking it. There is a scroll bar on the right to allow access to the entire list 

by browsing. 

You can either scroll through the list of test patterns or use the Find feature to search for patterns. When 

you press the Find activation button (located at the bottom of the window, as seen above), you are 

presented with a dialog window where you can search for a pattern by name using initial and mid-string 

partial searches. 
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The following example shows a search for patterns starting with “col” and returns two results: ColorBar and 

ColorBox. 

 

Using Custom List to select a Test Pattern 

The subtab Lists at the top of the window allows you to pick from a pre-defined list of patterns that you can 

compile using the Pattern Editor (covered in section 4.5, under Tools).  

Once again, this list will initially be empty, as shown in the following screenshot. Click the SELECT icon at 

the bottom of the panel to choose a list or set of lists. This is depicted below with two custom lists as options 

in the Select dialog box. 

 

  

   1. 

2. 
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You can select any or all of the custom pattern lists you have defined. The Check All and Un-Check All 

buttons allow convenient selection where you have many Pattern Lists to choose from. The result of 

selecting one custom Pattern List is shown in the following example. A limited set of patterns area displayed. 

The Path icon at bottom status panel will display that new list’s name (DemoList2). 

 

Configuring Test Patterns Settings 

Use the following procedures to select a test pattern. 

To specify test pattern settings: 

1. From the Pattern tab, click the Settings button on the lower center of the panel. 

 

The Settings dialog box appears as shown in the following screenshot: 
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2. Enable and disable Gamma and Pseudo-random noise and set the gating as desired. Refer to the table 

below for details on these optional settings. 

Pattern Settings - Gating Description Options 

Gamma Correction Enables or disables gamma correction which 

compensate for properties of human vision, to 

maximize the use of the bits or bandwidth relative to 

how humans perceive light and color. 

• On 

• Off 

Pseudo-Random Noise Renders a test pattern with high level of volatility 

between adjacent pixels. 
• On 

• Off 

Component Gating Turns on or off the three primary color components. • Red 

• Green 

• Blue 

3. Select the rendition where applicable using the Rendition button. The associated dialog box is shown 

further below. 

Some test patterns—such as GraysAll—have multiple versions. These multiple versions can be applied 

using the Rendition button and associated dialog box as shown below. There is a default that is iteration 

0. In the example below iteration 2 is currently being rendered on the sink DUT. 

 

4. Set the luminance level of the image with the Level button. The associated dialog box is shown further 

below. 

You can increment the color component values or can decrement the color component values for all 

pixels of any image through the front panel or the command line. This feature enables you to increment 

or decrement the values in increments (or decrements) of 1 throughout a range of 0 to 255. The LEVP 

feature increments or decrements all color component values (R,G,B) for each action by the use. 
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5. Set the pixel depth (PELD) if necessary through the Level button and associated dialog box in the 

previous screenshot. 

PELD establishes the number of data bits that represent each active pixel in video memory (frame 

buffer). Parameter. The default setting and setting of 8 allows 256 colors on an image (test pattern) to be 

rendered. This is suitable for the majority of test patterns. However, some test patterns contain more 

colors and either require PELD 32 or look optimal only when PELD is set to 32. The test pattern will 

indicate when PELD 32 setting is required.  

• Default - uses the M42d video generator default 

• 8 - 8 bits-per-pixel (256 colors) 

• 32 - 24 bits-per-pixel (16,777,216 colors). 

6. Set the pattern parameters, if necessary, through the Params button and associated dialog box shown 

below. The following table describes each parameter. 

 

Pattern Settings - 
Parameters 

Description 

OFFX Set horizontal offset for large patch of Regulate image 

OFFY Set vertical offset for large patch of Regulate image 

DELX Set horizontal shift for each step of SlideG/SlideRGB image 

DELY Set vertical shift for each step of SlideG/SlideRGB image 

DWEL Set number of frames for each step of SlideG/SlideRGB image 

PENW Set width variable for line thickness in EeRise, NAWC, and Slider 
images 

PENH Set height variable for line thickness in EeRise, NAWC, and Slider 
images 

SPAX Set horizontal spacing 

SPAY Set vertical spacing 

NCYC Internal use 
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 Testing audio on an audio rendering device 

The M42d supports audio testing for sink audio rendering devices. You can output LPCM audio over up to 8 

channels at user selectable sampling rates and bits per sample. The audio signal is a sine wave. You can 

also specify the amplitude and the frequency of the sine wave. You can also specify the amplitude and 

frequency of each channel separately. Use the following procedures to test a DP audio rendering device. 

Note: When generating DisplayPort Multistream, the audio signal that you specify will be transmitted on all 

virtual channels. 

To test an audio rendering device: 

From the Generator app of the M42d ATP Manager interface, select the Audio tab. If not already 

selected, click the PCM Sine Wave icon on the left side of the window. Both are shown below, as well as 

the full audio tab interface. 

 

The table below summarizes the M42d 80G Video Analyzer/Generator uncompressed LPCM 

programmable audio test tones. 

LPCM Programmable Sine Wave options 

Parameter Description Options 

Channels This is the number of 

channels in the audio sine 

wave test tone. 

• 2.0 

• 2.1 

• 5.1 

• 6.1 

• 7.1 
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LPCM Programmable Sine Wave options 

Parameter Description Options 

Sampling Rate This is the sampling rate of 

the audio sine wave test 

tone. 

• 32kHz 

• 44.1kHz 

• 48kHz 

• 88.2kHz 

• 96kHz 

• 176.4kHz 

• 192kHz 

Bits per Sample This is the number of bits 

per channel of the audio 

sine wave test tone. 

• 16 

• 20 

• 24 

Channel Selection Indicates the channels that 

are active. Also indicates 

the channel that is 

configured for the Level, 

Mute and Frequency 

Parameters. 

1. FL – Front Left 

2. FR – Front Right 

3. LFE – Low Frequency Effects 

4. FC – Front Center 

5. RL – Rear Left 

6. RR – Rear Right 

7. RLC – Rear Left Center 

8. RRC – Rear Right Center 

Level (dB) This is the amplitude of the 

audio sine wave test tone. 
• Increments in 3dB throughout a range of 

– 0dB to -99dB (per channel). 

Mute Mutes or unmwutes the 

audio for a particular 

channel. 

• On 

• Off 

Frequency (Hz) The frequency of the audio 
sine wave test tone. 
 

Programmable throughout a range of .008 

kHz to 20kHz (per channel) in increments 

of: 

• 1Hz 

• 10Hz 

• 100Hz 

• 1kHz 

 

Next to Channel Selection is a clickable icon which allows you to link channels together so that 

you can adjust settings for all of them at once. Click this icon and the Edit Channel Links dialog box 

appears, as shown in the following screenshot (Note: if you have 2.0 Channels selected, clicking this 

icon will simply link these two channels, and no dialog box will appear). 
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In this dialog box, you can select any number of channels you wish to link. Easily select All or None of 

the channels using the respective button. 

Once you have the channels selected that you wish to link, click the LINK button at the top of the 

dialog box. The following example has channels 1-3 selected and ready to link. 

 

After clicking LINK, the numbered boxes that you selected for linking will turn green. Click OK to be 

taken back to the main Audio testing interface.  

 

  

1. 

   2. 
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Notice that in the example below, Channels 1-3 are now only one clickable icon, and 4, 5, and 6 

remain separate.  

 

In this next example, all of the channels are linked: 

  

 

To change or unlink the channels, click the icon again to return to the Edit Channel Links dialog 

box. You must select the group of linked channels in the left column, as shown below. In this case 

there is only one grouping of linked channels. Click UNLINK at the top of the dialog box and then ok. 

The Channel Selection area will return to its previous form. 

 

Once you have entered your desired settings for audio testing, click at the bottom of the 

window.  

Click to see testing settings before or after applying changes. 

  

 

1. 

2. 
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 Tools 

The Tools tab has several utilities, located on the left sidebar. To access these, click on the Tools tab in the 

Generator app on the M42d ATP Manager. This section will review these tools in detail. 

 

Link Train 

The M42d 80G Video Analyzer/Generator enables you to control the link training with a DisplayPort sink 

device. There are three modes:  

▪ Adaptive Training 

▪ Non-Adaptive Training.  

▪ Fast Training 

Adaptive and Non-Adaptive are covered in this section, and Fast Training will be covered in Chapter 10 

Embedded DisplayPort (eDP) 

Adaptive Training enables you to train based on Lane Count and Link Rates capabilities that you define in 

the application. When you set the Lane Count and Link Rate in the Adaptive training mode you are 

emulating a DP source with those capabilities. The link will be established with the appropriate voltage swing 

level and pre-emphasis necessary to establish a proper link. 

In the Non-Adaptive mode, you are forcing the Lane Count and Link Rate as well as the voltage swing level 

and pre-emphasis and bypassing the typical link training function. 

Note: You can monitor the link training transactions with the Auxiliary Channel Analyzer (ACA) if desired. 
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Accessing the Link Training Control application 

Use the following procedure to test link training with your DP display device. This procedure assumes that 

you have already selected a DP VESA format and a test pattern to meet your test application requirements 

(Instructions for this found in sections 4.1 and 4.2. 

1. Access the Link Train control application through the Tools tab in the Generator interface as shown 

below.  

 

2. Select the link training mode tab (Adaptive or Non-Adapative) in accordance with your requirements.  

The first example on the following page will cover Adaptive Training. For Non-Adaptive Training, skip 

to step 5 
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3. Select the Train at Lane Count and Train at Link Rate parameters using the labeled icons provided (4 

lanes and 8.1Gbps link rate shown in the example below).  

The link training will occur after each selection is made; note the Current Status panel at the top of the 

screen. 

 

Note that in the top left of the screen, the Mode drop-down selection is still enabled, as shown below, 

allowing you to select either Single-Stream (SST) or Multi-Stream Transport (Multi-Stream Transport) 

mode for testing. 

 

Training at any rate 10.0 Gbps or above forces Mult-Stream Transport mode (Multi-Stream Transport). 

This will be demonstrated on the following pages. 

 

1 

 2 

  3 
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4. Click on the Train Based on Capabilities activation button to initiate link training that automatically 

trains at the highest capabilites of the DUT. 

The results and status of the link training will be shown on the Link Train application screen as shown 

below. The DUT in this example trained at 4 Lanes and 13.5 Gbps. 

Note: You can monitor the link training transactions with the Auxiliary Channel Analyzer (ACA) if 

desired. 

 

Note that the Mode drop-down menu is disabled (grayed out) because the Link Rate is above 10.0 

Gbps. Multi-Stream Transport is selected as it is the only option given these settings. 

 

This guide will expand on Multi-Stream Transport in section 4.6 Topology. 
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5. Optionally, select the Non-Adapative link training mode using the tab provided.  

6. Specify the Lane Count, Link Rate, Voltage Swing Level and Pre-emphasis level parameters. (Note 

that the link training does not automatically occur with each selection, unlike with Adaptive Training) 

7. Click on the Force Train activation button to initiate the link establishment using the parameters you 

have specified.  

Note: It is common that many combinations of link parameters will not establish a successful link, 

because the link training process is not occurring. 

The example below shows Non-Adaptive Link Training where the M42d force training at a Link Rate of 

8.10 Gbps with a Lane Count of 2, Voltage Swing Level of 1, and Pre-emphasis Level of 2.  

 

Note: You can monitor the link training transactions with the Auxiliary Channel Analyzer (ACA) if 

desired. 
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The second example below shows Non-Adaptive Link Training where the M42d forces training at a Link 

Rate of 13.5 Gbps at 4 lanes. UHD requires Multi-Stream Transport and requires an FFE Preset Value 

rather than Voltage Swing level and Pre-emphasis level. This difference is shown below as well as the 

resulting status of the force train. 
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DPCD Viewer 

Use the following procedures to view a display’s DPCD registers. 

Note: When the generator is configured for MultiStream, you can read the DPCD of any configured 

downstream sink. This is covered here, with more details on Multi-Stream Transport mode in section 4.5 

Topology and Multi-Stream Transport. You can also produce an HTML report of the DPCD registers, 

which is detailed at the end of this subsection. 

To view the DPCD of a connected display: 

1. From the main window of the M42d 80G Generator application, select the Tools tab and navigate to the 

DPCD Viewer interface using the button on the left-hand sidebar. 

 
 

  

1 

2 
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2. Multi-Stream Transport mode requires you to select a downstream device. If you are in SST mode, 

skip this page and move to step 3. 

a. If you are in Multi-Stream Transport Mode (indicated at the top left of the screen as shown 

below) and a port has not already been selected, you must select a port to read by clicking the 

dropdown that will read <NO PORT>. 

 

The following screenshot shows the interface with a DUT using Multi-Stream Transport: 

 
 

b. The Select a Device/Port dialog box will pop up. You can select any downstream sink or branch 

device. In the following example, Sink-4 has been selected. Click OK once you have selected 

the appropriate downstream device. 
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3. Select a Register page to read, and click READ PAGE to retrieve the DPCD report for that page. The 

register pages are listed on the left-hand side of the window in a new sidebar, as shown below. 

 

An example is shown below, with the first page of the Receiver Capability DPCD register displayed in 

the main panel. 

 

Alternatively, you can click READ ALL without selecting a register, and the DPCD report will be 

generated for all registers. 

 

4. Click on a different register to view its DPCD. The example below displays the DSC register on the main 

panel. 
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5. View additional blocks/pages of each register by navigating to them using the sidebar to the left of the 

main panel. The example below displays the Enable/Config page of the DSC register set. 

 

6. To view and save the DPCD of a connected display as an .html file, select REPORT at the top of the 

window: 
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The HTML report will be generated, allowing you to save to your desktop. 

 

Note: The HTML DPCD Register Report will only include registers of the sink device that were retrieved 

using steps 1 – 5. To ensure a full report of all registers, click the READ ALL button in the main DPCD 

viewer interface, as described in step 4. 
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HDCP Testing 

To test HDCP on a connected display using the Tools HDCP utility: 

1. Access the HDCP Test through the Tools tab in the Generator app as shown below. 

 

2. Enable HDCP by selecting either 1.3 or 2.3. The Status section will update automatically. View the 

results and status of the test through the HDCP Test screen as shown below. 
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Viewing the EDID of a connected display 

Note: You can read the EDID of any specific downstream node. Procedures for this are within this 

subsection, with more details on Multi-Stream Transport mode covered in section 4.6 Topology and Multi-

Stream Transport. 

To view the EDID of a connected display: 

1. From the Generator app of the M42d GUI Interface, select the Tools tab. 

2. Activate the EDID Decode button on the left-hand sidebar (indicated below). 

 

  

2 

1 
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3. Multi-Stream Transport mode requires you to select a downstream device. If you are in SST mode, 

skip this page and move to step 4. 

 If you are in Multi-Stream Transport Mode (indicated at the top left of the screen as shown below) and a 

port has not already been selected, you must select a port to read by clicking the dropdown that will read 

<NO PORT>. 

 

The following screenshot shows the interface with a DUT using Multi-Stream Transport: 

 

 

The Select a Device/Port dialog box will pop up. You can select any downstream sink. In the following 

example, Sink-4 has been selected. Click OK once you have selected the appropriate downstream 

device. 
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4. Click the Read button at the top left of the window. 

 

The EDID Decode content will be shown as in the example below 

 

5. Navigate through the blocks and pages of the EDID using the arrow buttons on the lower panel 

(indicated below). 
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Examples of the EDID Decode second and third blocks are shown below. 
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DSC (Display Stream Compression) 

The M42d 80G Video Analyzer/Generator supports a DSC/FEC video generator function. You can output 

DSC/FEC streams with a user selectable slice configuration, various compression settings, bit depths, 

colorimetry, etc. You can import your own configuration parameters from a Picture Parameter Set (PPS) of 

values. You can select from a set of provided DSC images or import your own DPX images. 

Display Stream Compression display testing is supported through the standard DP Tx port or the USB-C DP 

alt mode port. 

To test a DSC/FEC-capable display device: 

From the Tools tab of the Generator app, select the DSC button in the left-hand sidebar. The DSC tools 

panel appears as shown below. 

 

A list of Available Images will appear in the top panel. There are many by default on the M42d itself, 

otherwise you can add your own using the Import DPX button at the top right. This will be covered in the 

next subsection.  

 

 



M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 74  July 18, 2021 

 

Select a file from Available Images by clicking on it. Options will appear in the Allowed Formats panel 

below, as shown in the following example. The first format is selected by default. Click APPLY once you 

have the desired image and format. 

 

Once a file is selected, the lower information panel shows the parameters of the selected video frame file 

and the In Use area at the top left shows the selected file name. 

The Settings dialog box is accessed using the Settings button at the top left of the window. 

 

The Settings dialog box is shown below. You can set the video parameters, compression, slice 

configuration, etc. here, or import a custom set of PPS parameters from a text file. The Selections for the 

dialog box are described on the table that follows. 
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The Settings dialog box parameters are described below: 

DSC Video Generator Settings Dialog Box 

Item Parameters Comments 

Color Mode Selections are:  

- RGB 

- 4:4:4 

- 4:2:2 Simple 

- 4:2:2 Native 

- 4:2:0 

 

Bits Per Component The color depth per component. Options 

are: 

- 8 

- 10 

- 12 

These selections would be 24, 30 

or 36 respectively for color depth 

per pixel. 

Bits/Pixel This is the compression, i.e. the number 

of bits per pixels desired in the 

compressed output. 

Select throughout a range of 8 to 15. 

The compression ratio can be 

calculated as Bits per Component x 

3 / Bits per Pixel. 

Example: 8 bit color depth: 

8 x 3 = 24 / 8 = 3:1 compression 

ratio. 

Slice Width (pixels) The Width in number of pixels across a 

slice. 

All slices have to be the same size 

and they are all rectangular. 

Slice Height (lines) The Height in number of lines in a slice. 

Block Prediction This selection indicates if the video 

generator will use Block Prediction. 

Block prediction is an optional 

prediction method for the sink. You 

must be sure that the display you 

are testing supports Block 

Prediction. 

Line Buffer Bit Depth This is a Picture Parameter Set (PPS) 

parameter. It is used to generate the 

bitstream. You can set this value or 

import this value as part of a 

Configuration File using the Custom tab.  

You can import a text file to use. 

 

  



M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 76  July 18, 2021 

 

Here is a sample of a .txt Configuration File that you can import: 

SRC_LIST /qd/dsc_images/cache/src_list.txt 

FUNCTION 1 

OUT_DIR /qd/dsc_images 

DSC_VERSION_MINOR 32628 

SLICE_WIDTH 3840 

SLICE_HEIGHT 1080 

INCLUDE    /qd/dsc_images/cfg/rc_8bpc_8bpp.cfg 

DPX_FILE_OUTPUT 0 

BLOCK_PRED_ENABLE 1 

LINE_BUFFER_BPC 16 

//  DPX read options (the following work well for most modes for GM/IM, some 

anomalies are autodetected) 

DPXR_PAD_ENDS      1   // Pad to 32-bit boundaries 

DPXR_DATUM_ORDER  1 

DPXR_FORCE_BE      0 

SWAP_R_AND_B  1 

//  DPX write options (the following work well for most modes for GM/IM) 

DPXW_PAD_ENDS      1   // Required to output RGB to XNView 1.99 (but not 

YUV!) 

DPXW_DATUM_ORDER   1 

DPXW_FORCE_PACKING 1   // Method to use for 10 & 12-bit data 

SWAP_R_AND_B_OUT   1 

PPM_FILE_OUTPUT 0       // Output PPM files 
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Importing a DPX 

Import your own DPX by clicking the Import DPX button in the top right of the DSC window, shown below. 

You may also Delete a file from the Available Images panel or Refresh this listing to show current available 

files. 

 

From the DPX Image Import dialog box, select the DPX File for Import by clicking the Browse button. Add 

or Remove any supported formats, and click the IMPORT button to add to the list of Available Images. 

 

Note: You may need to click the Refresh button in the top right for the newly imported DPX Image to display 

in the list of Available Images. 
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Other Tools 

The tools tab has several other utilities: 

▪ ALPM (Advanced Link Power Management) – A utility for embedded DisplayPort (eDP). This will be 

discussed in Chapter 10 eDP. 

▪ Backlight – Also for eDP, discussed in Chapter 10 eDP. 

▪ USB-C – Change Supported Pin Assignments. Power Role Swap is not currently supported on the 

M42d. 

 

 

▪ EDID Comp – Compare the EDIDS of two sink devices, a sink device vs an imported EDID, or two 

imported EDIDs vs one another. 

• Select the EDID Comp utility from the Tools tab. 

From here you can select which EDIDs to compare. If you are comparing imported EDIDs, 

click the Select button to import. The following example is comparing a sink device vs an 

imported EDID. 

 

The next example shows two sink devices and the result after clicking the COMPARE 

button. 
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▪ Editors – Create a custom format or custom lists of patterns and formats. Screenshot example 

below. 

 

▪ Scripts – Allows user to implement custom functionality based on low level instrument commands by 

loading a batch shell script into the directory folder. 

Note: A batch shell script must be loaded into the folder path using an external file explorer. 
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 Topology and Multi-Stream Transport (Multi-Stream Transport) 

The M42d 80G Video Analyzer/Generator emulates an Multi-Stream Transport source for testing an Multi-

Stream Transport branch device or Multi-Stream Transport-capable monitor. Up to four (4) streams are 

supported depending on bandwidth (resolutions) with a depth of one. You can configure the Multi-Stream 

Transport topology using a graphical interface. The optional Auxiliary Channel Analyzer (ACA) utility depicts 

the Multi-Stream Transport negotiations with the connected Multi-Stream Transport Rx device. 

When Multi-Stream Transport is configured, the same video pattern and audio signal is transmitted to all 

downstream nodes. There is a number indicator that appears on the upper left screen of the downstream 

Multi-Stream Transport sink that identifies which stream is being delivered. 

Note: Multi-Stream Transport testing is supported through both the standard DP port and the USB-C DP alt 

mode port. 

Accessing the Multi-Stream Transport Topology window 

Use the following procedure to test Multi-Stream Transport on a connected Multi-Stream Transport-Capable 

sink device. 

1. At the Generator dialog box, select Multi-Stream Transport from the Interface drop down menu. Refer to 

the screen example below. 

 

Click OK when the confirmation dialog box appears. 

Note If the Mode dropdown is unselectable (grayed out, as shown below), then the Sink device has 

been trained at a UHD link rate, which requires Multi-Stream Transport. If this is the case, and you would 

like the option to select Mode: SST, refer to the subsection of this chapter titled Returning to SST 

Mode. 
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2. From the Generator window, access the Topology tab to control the Multi-Stream Transport application 

as shown below. Notice the Mode has been switched to Multi-Stream Transport after the previous step. 

 

The table below summarizes the graphical controls of the Multi-Stream Transport Topology window. 

Multi-Stream Transport Topology Window 

Button Description 

Read EDID Enables you to read the EDID of the selected downstream Multi-

Stream Transport Rx node. 

Read DPCD Enables you to read the DPCD of the selected downstream Multi-

Stream Transport Rx node.  

Virtual Channels 

VC #1…VC #4 

Select the virtual channel to analyze 

Refresh Refreshes the view. 
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Configuring the number of downstream Multi-Stream Transport nodes. 

Use the following procedure to configure the number of downstream Multi-Stream Transport nodes. 

To access the Multi-Stream Transport dialog box: 

1. Using the embedded ATP Manager GUI on the M42d, navigate to the DisplayPort/USBC 2.0 Protocol 

Analyzer RX interface, or the Receiver interface on a remote PC ATP Manager. 

 

Note: This application is covered in detail in Chapter 4 Source Verification with Basic Analyzer 

2. Click the Tools button on the right sidebar. 

3. The Tools dialog box will appear. Select the Multi-Stream Transport tab within this dialog box, as 

shown below. 
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The previous screenshot shows the dialog box with a device that has link trained at 10.0, 13.5, or 20.0 

Gb/s. These rates are UHBR which require Multi-Stream Transport, and SST is not an option under 

Mode.  

The next example of the dialog box below shows a device link trained at 8.1 Gb/s or lower.  

The dialog box has three fields: 

▪ Mode: Select between SST and Multi-Stream Transport 

▪ Virtual Channel to Show: Select which virtual channel to display within the Protocol 

Analyzer/Receiver. 

▪ Configured Stream Count: Change the number of streams between transmitted by the Generator. 
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To add/remove a downstream node: 

This dialog box enables the user to add or remove a downstream node. Select the desired number of nodes 

in the Configured Stream Count field. The following example has selected two streams. 

Note: After selecting a stream count, you must reboot the M42d for the changes to apply. You will also need 

to retrain to the desired link rate after the reboot, if applicable. 

 

After rebooting, navigate to the Topology tab to verify the number of downstream nodes. Continuing from 

the previous example, the topology now displays a branch device and two sinks, as shown below. 
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Reading the EDID or DPCD of a downstream Multi-Stream Transport node 

EDID Decode and DPCD Viewer are covered in section 4.5 Tools, but there is another way to access these 

utilities while in Multi-Stream Transport mode from the Topology tab. 

The Read EDID and Read DPCD buttons are located at the top left of the window in the Topology tab 

(shown below). Clicking either of these will take you to the respective utility in the Tools tab. The example 

below has Sink-4 selected. 

 

Returning to Single-Stream Transport (SST) Mode 

If your device previously trained at a link rate of 8.1 Gbps or lower, returning to SST mode is as simple as 

clicking the Mode drop down in the top left and selecting Mode: SST as depicted below. 
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If the Mode: Multi-Stream Transport drop down is not clickable, your sink device is likely trained at a UHD 

link rate (10.0 Gbps or higher), which requires Multi-Stream Transport mode. You must use the Link Train 

utility in the Tools tab to train at a link rate of 8.1 Gbps or lower. 

An example of this is depicted below. More on link training can be found in the Link Train subsection of 

this chapter.  

 

Note: Do not click on TRAIN BASED ON CAPABILITIES as this will likely train at a link rate higher than 

desired for SST. 

SST mode will be selected by default after this link training, as shown below. 
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4 Source Verification with Basic (Real-time) Analyzer 

Basic Analyzer Description  

▪ Emulates an DP 1.4 or DP 2.0 sink device including EDID, DPCD, Multi-Stream Transport, Link 

Training emulation.  

▪ Provides real time view of the incoming source video and metadata including status of mainstream 

attributes, secondary data packets, link training, Multi-Stream Transport, HDCP.  

▪ Provides support for viewing the Aux Channel transactions using the quantumdata Auxiliary Channel 

Analyzer (ACA) application when testing a DP source. 

Note: Chapter 5 will cover the Protocol Analyzer/Capture Control function of the M42d. 

 Accessing Basic Analyzer Features 

From the Home screen of the M42d ATP Manager, select the DisplayPort/USBC 2.0 Protocol Analyzer 

Rx app, as shown below.  

 

The Analyzer panel appears showing the incoming video image. The M42d’s Rx analyzer port provides 

periodic video frame captures enabling you to view frames of video. This feature provides a basic 

confidence test to verify that the incoming video is essentially correct. 

  



M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 89  July 18, 2021 

 

There is a dashboard on the top of the panel indicating the essential video characteristics, and there is a set 

of controls on the right-hand side, as shown below. 

 

Note: The Analyzer panel is not transmitted to a Remote PC ATP Manager. When selecting the Receiver 

on a desktop ATP Manager, only the Tools dialog box (discussed later in this chapter) will appear, as shown 

below. The Analyzer panel is accessible remotely using a VNC. This is discussed in 2.5 VNC Remote 

Connection. 

 

For this reason, most instructions and screenshots in the next two chapters are from the embedded ATP 

Manager GUI on the M42d device itself. 
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Basic Analyzer Dashboard 

This subsection describes the dashboard components on the top of the Basic Analyzer panel. Refer to the 

table below for a description of these components. 

Basic Analyzer – Dashboard Items 

Example dashboard of DisplayPort 2.0 Protocol Analyzer Rx 

Example using USB-C DP-alt mode with DSC enabled and active 

 

  The following items are on the Real Time dashboard: 

Top Row Items – Module and Port: 

▪ Port  - The Port area shows the current Rx port 

that is being displayed on the Basic Analyzer. 

Second Row Items: 

▪ Monitor  - Indicates the HDCP encryption status of the received video. 

Note: If unencrypted, this will be the indicator:  

▪ LTTPR Emulation  - Indicates whether LTTPR emulation is active 

▪ Passive Monitor  – Indicates whether passive monitoring is 

enabled.  

Third Row Items: 

▪ Measured  or - Indicates whether USB-C or DP (DisplayPort) is 

currently connected. 

▪ Lanes  - The number of lanes used during link training. 

▪ Bandwidth  - The link rate (per lane). 

▪ Active (video resolution)  - This is the measured video resolution. 

Note: If DSC is active this will be indicated . 

▪ V-Total  - This is the measured total vertical video lines per frame. 

▪ VRate - This is the measured vertical frame rate 

Fourth Row Items: 

▪ Res  - The active video resolution in horizontal pixels and vertical lines 

determined from the main stream attributes. 

▪ Total  - The total video in horizontal pixels and vertical lines determined from 

the main stream attributes. 
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Basic Analyzer – Dashboard Items 

▪ Sync  - Horizontal sync pulse width (in pixels) and polarity, followed by vertical sync 

pulse width (in lines) and polarity. (e.g. Hsync 88 pixels, positive; Vsync 10 lines, positive) 

▪ Start  - The starting pixel and line in the active video determined from the main 

stream attributes. 

▪ Colorimetry and bit depth  - The colorimetry and bit depth determined 

from the main stream attributes. 

▪ Scan  - The scan type used, progressive (e.g. Prog) or interlaced (Inter) determined 

from the main stream attributes. 

Fifth Row Items: 

▪ Sync-Clk  - Indicates if the Link Clock and Main Video Stream clock are asynchronous 

or synchronous. A value of N means async; a value of Y means synchronous. This value is determined 

by the main stream attributes. 

▪ Stereo-3D  - The status of 3D audio determined from the main stream attributes. 

▪ Mute  - The AudioMute flag status determined from the main stream attributes. 

▪ Vfreq  - Video pixel frequency determined from the main stream attributes. 

▪ Afreq - Audio sampling frequency determined from the main stream attributes. 

Sixth Row Items: 

▪ Pixel Clock  - How often pixels occur (frame rate x pixels per frame) 

▪ DwnSp  - DownSpread indicates whether Spread Spectrum Clocking (SSC) is enabled 

▪ HDCP-Enc  – Indicates if HDCP encryption is currently active 
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Main Control Panel 

This subsection describes the main control panel for the Basic Analyzer. Refer to the table below for a 

description of these controls. This chapter expands on many of the tools presented in this table in later 

sections. 

Basic Analyzer – 

Control Panel 

Control Button Descriptions 

Main Control Panel  

  

 

The following controls are provided in the main control panel on the right edge of 

the Real Time mode interface. Each of the buttons have a pull-down menu 

associated with them. The purpose of each button and their basic control 

functions are described below: 

▪ Home – The Home button  is a navigation button that when 

pressed takes you back to the home screen Apps Panel. 

▪ Back – The Back button  is a navigation button that when pressed 

takes you back to the previously viewed screen. 

▪ Start/Stop –The Start / Stop button  /  is used to enable 

and disable the showing of the incoming video image. 

▪ Color – The Color button  and associated dialog box enables you 

to identify the color of any particular pixel. 

▪ Scale – The Scale button  and associated dialog box enables you 

to set the size, quality and aspect ratio of the incoming video image. 

▪ PPS – The PPS button  brings up the Picture Parameter Set 

panel. Used with DSC Analysis. 

▪ VSC – The VSC button  displays Video Stream Configuration data 

▪ ACA – The ACA button  is used to bring up the ACA utility. 

▪ Set EDID – The Set EDID button  is used to set the EDID  

▪ Set DPCD – The Set DPCD button  is used to set the DPCD 

▪ Tools – The Tools button  brings up the Tools dialog box, which 

will be discussed in detail later in this chapter.  

▪ Passive Monitor – The Passive Monitor button allows you to 

toggle Passive Monitor mode.  

Note: More details on Passive Monitoring are found in Chapter 7 Passive 

Monitoring. 
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 Controlling the Basic Analyzer 

This subsection provides procedures on how to control the Basic Analyzer features. 

Viewing the Color values 

The M42d enables you to determine the color values of any individual pixel. 

1. Access the Color dialog box by clicking the icon on the right-hand side control panel, as shown below. 

 

The Video Color dialog box will open. 
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2. Click on any location within the video frame to read its pixel color. You can also move to the adjacent 

pixels with the green arrow buttons provided in the dialog box, as shown below. 

 

3. Read the pixel values on the dialog box provided. The pixel values (X for the horizontal – Y for the 

vertical) are provided in both hex and decimal.  



M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 95  July 18, 2021 

 

Setting the video image size and aspect ratio 

The M42d enables you to set the size and aspect ratio of the displayed video image. 

Access the Image Scale dialog box by clicking the Scale icon on the right-hand side control panel, as 

shown below.  

 

Set the size to either 1:1 or Scaled.  

▪ The 1:1 setting means that the image appears in its true size. In this mode, if the image is too large 

for the viewing panel, it can be moved by clicking and dragging to view all areas of the image. 

▪ The Scaled setting means that the image appears scaled to fit within the viewing area of the M42d’s 

ATP GUI display, or within the Aspect Ratio defined. 

The example below shows Image Scale set to Scaled with an Aspect Ratio set Fit the viewing panel. 
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This final example below is in Scaled mode with an Aspect Ratio of 4:3. 

Note: In order to set the Quality and the Aspect Ratio you must set the Mode to Scaled. 

 

Note: Scaling uses simple decimation, so some fine image details may be inaccurate or lost.  
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Monitoring transactions using the ACA Utility 

You can monitor the Aux channel transactions from the ACA Utility, as well. The Aux Channel Analyzer is 

covered in detail in Chapter 6. The tool is discussed briefly here, but you can refer to Chapter 6 for a more 

in-depth look at the ACA utility. 

Access the ACA Utility by clicking the ACA button on the right-hand sidebar, as shown below. 

 

 

Click Start to begin monitoring the Aux Channel transactions. The ACA Utility will begin monitoring for Aux 

transactions and display them, as shown below. 
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Click the Options flyout menu to toggle certain viewing settings. In the example below, the Time-Stamps 

and Port Names for each event are displayed. 

 

 

In the ACA Utility, you can click the Events button for a dialog box that enables you to select which events 

you would like the Analyzer to display. Easily select All or No events, or check the specific events you would 

like to monitor. In the example below, all DP Native, EDID, and Multi-Stream Transport Transaction events 

are selected. 

 

  

Time-stamp 

Port Name 
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Click the Events button for a dialog box displaying the details of the selected event. Easily navigate to the 

previous or next event inside this box using the arrows at the top, as shown in the two dialog boxes below. 
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Setting the EDID for the Rx port 

The M42d enables you to set Rx ports EDID for emulation. The ATP GUI provides an EDID Editor enabling 

you to create your own custom EDIDs. You can also capture EDIDs from the M42d’s Tx ports and save 

them for testing on the Rx port. 

1. Access the Set EDID dialog box by clicking the Set EDID button on the right-hand sidebar, as shown 

below. 
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2. Select the EDID that you wish to emulate on the module’s Rx port and then click OK. 

 

3. You may also wish to generate a hot plug while setting EDID or set the EDID permanently. You can do 

these by toggling either setting in the Set RX EDID dialog box, as shown below. 

 

The M42d’s Rx port will emulate the EDID you selected. 

Refer to the section of Chapter 3 titled Viewing EDIDs of a Connected Display for instructions on how to 

capture EDIDs from HDTVs. 
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Setting the DPCD for the Rx port 

The M42d enables you to set the DPCD. The ATP GUI provides an DPCD Editor enabling you to create 

your own custom DPCDs, as well.  

1. Access the Set DPCD dialog box by clicking the Set DPCD button on the right-hand sidebar, as shown 

below. 

 

2. Select the desired DPCD and then click OK. 

 

Refer to the section of Chapter 3 titled DPCD Viewer for instructions on how to view a display’s DPCD 

registers. 
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 Tools Dialog Box 

The Tools dialog box offers additional features, options, and statuses within it. This section will cover these 

in varying detail. Access the Tools dialog box by clicking the Tools button on the right-hand side control 

menu, as shown below. 

Overview of Tools dialog box selections: 

▪ Link Status- Provides information on the Rx Main Link lanes and link rate 

▪ LTTPR- Access tools for LTTPR Emulation (license required). This feature is covered in Chapter 8 

LTTPR Testing 

▪ Multi-Stream Transport- Provides for Multi-Stream Transport configuration. This feature is covered 

in detail in 4.6 Topology and Multi-Stream Transport. 

▪ Hot-plug- Generate a hot-plug pulse of duration between .1 – 4000 milliseconds. Example shown 

below 
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▪ HDCP- Enable/Disable HDCP or select version. You may also edit the Key Type or Bcaps from this 

screen. 

In the exampled shown below, HDCP 2.3 is enabled. 

 

▪ ALPM- Advanced Link Power Management: Provides information on ALPM States 

▪ eDP- Enable or Disable embedded DisplayPort. This feature is covered in Chapter 10 eDP. 

▪ USB-C- Select from supported USB-C Pin Assignments 

▪ Error Info- Displays status of Forward Error Correction (FEC). FEC is enabled in the example 

shown below. 
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▪ Backlight- Displays backlight intensity percentage.  

▪ SPDIF / Trigger- Allows you to Toggle SPDIF and/or Trigger output. 
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 DSC Analysis  

This section covers Display Stream Compression features within the Analyzer. 

DSC Real-time (Snapshot) Analysis 

The DSC Analysis feature allows you to view the incoming DSC decompressed frame. The DSC video is 

presented as a series of snapshots (not “real time”). You will be able to see the DSC metadata in the Picture 

Parameter Set (PPS).  

To access the Picture Parameter Set panel in the Analyzer interface, select the PPS button from the right-

hand side controls. The PPS panel is shown below. 
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DSC Test CRC Verification 

You can also verify the Test CRC of the incoming DSC decompressed frame to support test automation on 

Display Stream Compressed (DSC) frames.  

The DisplayPort specification requires registers in a DSC-capable sink device for exposing calculated CRCs 

on the decompressed (“reconstructed”) pixel values. This enables a DSC source developer to acquire an 

objective verification that their compression engine is working properly. 

Prior to this, a developer would have to view the compressed image frames received by the M42d and 

subjectively assess the compression through a visual inspection. 

The source DUT transmits a DSC compressed frame to the DSC sink. The Test CRC registers in the sink (in 

this case the M42d analyzer emulating a sink) now expose the calculated values to be read by the source, 

thus enabling the verification. Developers of a DSC-capable source can read these registers over the Aux 

Channel. 

Accessing and reading the DPCD register is covered in the Chapter 3 section titled DPCD viewer. To 

access the CRC Test readouts, select the Test Automation register and click Set 3, as shown in the example 

below. 
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5 Protocol Analyzer with Capture Control 

Protocol Analyzer Description: 

▪ Requires the Basic Analyzer license to be installed as well. 

▪ Provides capture and store of the main link protocol, video and metadata including main stream 

attributes and secondary data from an incoming DP source device.  

Operational workflow for capturing data with your M42d DP Protocol Analyzer  

This subsection describes how to use the M42d analyzer function to capture and analyze DisplayPort source 

devices. Testing an DP source device involves the following high-level steps:  

1. Configure the M42d analyzer with the proper EDID. 

2. Connecting the DP source device. (see Chapter 3 Connecting DUT) 

3. View the incoming video in real time to check the status of the device under test. 

4. Specify a trigger method. 

5. Initiate the capturing of the data. 

6. Examine the test data through the ATP GUI Manager at the high-level view on the Event Plot panel or 

the Video Analysis panel. 

7. Drill down to examine the data at the lower level through the details of the Data Decode panel view.  

8. (Optional) You may wish to capture and view the raw hex data. 
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 Getting started with the Protocol Analyzer 

Configuring the M42d DP Protocol Analyzer with an EDID 

Use the procedures below to provision the M42d Rx port with an EDID to emulate a sink device. 

4. Open the DisplayPort/USBC 2.0 Protocol Analyzer from the home screen. 

5. Access the Set EDID dialog box by clicking the Set EDID button on the right-hand sidebar, as shown 

below. 
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6. Select the EDID that you wish to emulate on the module’s Rx port and then click OK. 

 

7. You may also wish to generate a hot plug while setting EDID or set the EDID permanently. You can do 

these by toggling either setting in the Set RX EDID dialog box, as shown below. 

 

The M42d’s Rx port will emulate the EDID you selected.  
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Verifying source video 

Before you capture data, you should verify that you are receiving DisplayPort video from the source. 

Verify the incoming video of the DisplayPort source to ensure that the source is outputting the proper video. 

In the screen example below the video shown is a test pattern. Typically, the video you will see will be from 

a PC or some other source. Verify the information in the top status bar. 
  

 

 

The following is an example of a Real Time view with USB-C source 
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 Capture Control Panel 

Access the Capture Control app from the Home Screen of the ATP Manager interface. 

You initiate a new capture through the Capture Control panel. The Capture Control panel enables you to 

setup the capture parameters. The figure below shows the Capture Control panel and its control and 

selection items. 

 

The following table describes the functions of the Capture Control panel, specifically the Data tab: 

Capture Control Panel - 

Function 

Item - Description 

Buffer Size • Enables you to set the size of the captured data in percent.  

• This is a slidebar that provides an indication (on the left) of the 

percent of the total possible size to be captured. A lower value will 

require less time for the captured data to accumulate. 

Trigger Position within Buffer • Enables you to set the position of the trigger event within the 

captured data.  

• This slidebar determines how much of the data that has 

accumulated in the capture buffer has occurred before the trigger 
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Capture Control Panel - 

Function 

Item - Description 

event. The slidebar has an indication (on the left) of the location of 

the trigger event within the captured data. The value is expressed as 

a percent.  

• A value of 0% indicates that the trigger event occurs at the 

beginning of the resulting captured data and 100% indicates that the 

trigger event occurs at the end of the resulting captured data.  

• A value of 50% indicates that the trigger event is in the middle of the 

captured data. 

• Note: The Buffer Position Slidebar is not applicable when you select 

Vsync as the trigger condition. 

Trigger Mode  

 
• Enables you to specify the type of data that you want to capture. 

• Note: This is covered in greater detail after this table. 

Trigger Count • Option to specify which occurrence of the selected trigger event will 

initiate capture 

• eg. a Trigger Count of 5 will start capture at the 5th occurrence of the 

trigger event 

Extract Video Frames • Enables you to view the video frames that were captured. 

Decompress DSC Frames  • Makes video frames viewable if DSC mode is enabled 

• Extract Video Frames toggle must be enabled for this option to be 

active 

Capture AUX (ACA) 

Transactions 
• Enables you to capture the Aux Channel transactions 

Start Capture (Capture Tab) • Initiates a capture using the criteria defined in the Trigger Mode 

and Trigger Symbol. 

 

The Trigger Mode drop down selection allows you to pick the specific event occurrence that will initiate the 

capture. You may use the radio buttons to select a trigger at Any Rate or Non-UHBR Only 
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With the Any Rate radio button selected, a set of options is selectable from the drop-down menu beneath it, 

as shown below and described in the following table: 

Any Rate Trigger Mode Drop Down Menu Trigger Options 

 

• Start of vertical blanking (SST) or SR/LLCPM 

symbol (Multi-Stream Transport) 

• SDP Type Received 

• SDP Type Not Received 

• VB-ID Received 

• VB-ID Not Received 

• AUX Read or Write (Only Writes in Passive Mode) 

• Start of TPS2 as indicated by DPCD 0x00102 

• Exit from TPS2 as indicated by DPCD 0x00102 

• Start of HDCP 2.2 (N/A in Passive Mode) 

• Exit from HDCP 2.2 (N/A in Passive Mode) 

 

When selecting Non-UHBR Only Trigger, another set of options is selectable from the drop-down menu 

beneath it. A few of these triggers require you to select the lane for the trigger to occur on, as shown and 

described in the table below.  

Non-UHBR Only Trigger Mode Drop Down Trigger Options 

 

If Specified Symbol is selected then select one of: 

• BS=Blanking Start 

• BE=Blanking End 

• BF=Blanking Fill 

• C0-C7=VC Payload Fill Control code sequence 

• CP=Content Protection 

• FE=Fill End, FS=Fill Start 

• R0-2 

• SE=Secondary Data End 

• SR=Scrambler Reset, 

• SS=Secondary Data Start 

• Other 
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• Data Byte Value 

• 8B10B Symbol Error 

• 8B10B Disparity Error 

• Start of TPS3 as indicated by DPCD 0x00102 

• Exit from TPS3 as indicated by DPCD 0x00102 

• Start of TPS4 as indicated by DPCD 0x00102 

• Exit from TPS4 as indicated by DPCD 0x00102 

• Start of HDCP 1.3 (N/A in Passive Mode) 

• Exit from HDCP 1.3 (N/A in Passive Mode) 

• FEC Decode Enable Sequence 

• FEC Decode Disable Sequence 

• ML_PHY_STANDBY detected on main link 

• ML_PHY_SLEEP detected on main link 

• AUX_PHY_WAKE detected on AUX channel 

 

The next subsection will describe the procedures for capturing and viewing data using Capture Control.  



M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 116  July 18, 2021 

 

Capturing Displayport source data 

The procedures for running a capture of the DisplayPort source are described in this subsection. You can 

operate the Protocol Analyzer either through the M42d ATP GUI or via a PC through the external ATP GUI 

Manager. Most of the examples in this section are taken from the embedded ATP GUI Manager but the look 

and feel are quite similar between the two. 

Capturing DisplayPort source data 

1. Access the Capture Control application from the ATP Manager home screen. 

The Capture Control window opens as shown below. 

 

2. Select the port using the Select  activation button at the top of the window. 

3. Specify the Buffer Size and Trigger Position, Mode, and Count in accordance with the information 

provided earlier in this chapter. 

4. Toggle on or off the options to Extract Video Frames, Decompress DSC (if applicable), and Capture 

AUX (ACA) Transactions. 

5. Initiate the capture by clicking on the Start Capture activation button 

 

You will be prompted with a New Capture dialog box (below) given you an opportunity to assign a name 

to the capture file. 



M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 117  July 18, 2021 

 

 

6. Enter a name in the space provided in the New Capture dialog box. 

Click OK to begin the capture process. A progress bar will appear, as shown below.  

If the capture trigger event does not occur, you may click the MANUAL TRIGGER or STOP AND SAVE 

DATA buttons. They are described below. You can also CANCEL the capture at any time. 

▪ Manual Trigger – If the trigger event does not occur as expected, or if you are viewing the video 

display in real time and you notice an occurrence that you would like to capture the data of, manually 

initiate a capture with the previously set specifications at this point. 

▪ Stop and Save Data – If the capture is not triggered as expected, you can essentially cancel the 

capture and keep the raw data for later analysis.  

 

Once the capture trigger event has occurred, the data will be decoded and saved for viewing. An 

example of the progress bar while this occurs is below. 
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When the capture is complete, the data is presented in the DP Capture Viewer. An example of the captured 

data is shown in the screen shot example below.  

 

The Capture Viewer and its features/functionality is covered in much detail in the next two sections of this 

chapter. 5.4 Capture Viewer Panels covers the Event Plot, Data Decode/Details, and Link Symbol panels, 

while 5.5 Searching and Filtering for Specific Data Elements covers searching for events or symbols, and 

filtering using the functions within the Capture Viewer.  
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Opening an Existing Capture 

Before covering the DP Capture Viewer in detail in the following sections, this subsection will go over 

opening a previously saved capture within the Capture Viewer.   

After running a capture, the DP Capture Viewer opens to display the resulting data, as shown below. 

 

The Capture Viewer can also be opened from the Home screen of the ATP Manager. Click the Other tab, 

and select the DP Capture Viewer icon, as shown below. 
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Once in the Capture Viewer, click the Open button at the top right of the window, as shown below. 

 

 

A dialog box will open up, prompting you to select a capture file, as shown below. Select the capture you 

wish to open and click OK. 
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 Capture Viewer Panels 

Capture Viewer Overview 

The Capture Viewer enables you to locate data by searching for specific data types, panning, scrolling and 

zooming using various techniques. You can filter the data by type to limit the amount of data to sift through. 

There are three (3) panels in the Capture Viewer: 

• Event Plot Panel – Visual presentation of the audio, video, metadata, protocol and control 

elements. 

• Data Decode (Transactions panel and Details panel) – Tabular chronology of audio, video, 

metadata, protocol and control elements with precise timestamps assigned. Enable searching and 

filtering. 

• Link Symbol Panel – Table of link symbol values in hex for all lanes. 

The panels are synchronized with one another. When a datum is selected, it automatically selects the 

corresponding information in the other two panels. Refer to the screen capture and information below. 

 

Before looking at the Capture Viewer panels, the following subsection will cover the toolbar at the top of the 

Capture Viewer interface.   
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Capture Viewer Toolbar 

The toolbar at the top of the Capture Viewer interface enables you to view, find, or filter for specific data 

types, as well as customize the format that the time is displayed in. You can also open or simply view the 

different virtual channels captured. 

Additionally, certain utilities on the toolbar are accessible if the option was enabled when executing the 

capture in the previous steps, specifically the Frames tab and ACA Data Viewer. 

A screenshot of the toolbar is below. Note that the Open VC and VC Viewer toolbar buttons at the top right 

are utilized during UHD/Multi-Stream Transport transport captures. This is covered later in this section. 

 

If the Extract Video Frames and/or Capture AUX (ACA) Transactions options were toggled off when 

starting the capture, those buttons will be greyed out, as shown below. 

 

Open Segment 

The Open Segment button  is enabled when performing a large capture. The capture is 

broken up into segments within the Capture Viewer, and you can click Open Segment to view the segment 

in its entirety. 

Rows 

The Rows button brings up the Row Selection/Ordering dialog box, as shown below. The 

following example has Data, Errors, Markers, and CSB (Channel Status Block) rows selected and ordered. 

Make a row visible in the Event Plot Panel by clicking on it in the Available Rows (left-hand) column. Re-

order using the arrows in the Row Order (right-hand) column. Remove a row by clicking it again in the 

Available Rows column or selecting it in the Row Order column and clicking the red X at the top of the 

column, as shown below. 
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The Capture Viewer window with these settings will display as follows, with the selected rows in the Event 

Plot Panel. 

 

 

The Events and Find buttons will be covered in Section 6.5 Searching and 

Filtering for Specific Data Elements.  
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Time: 

The Time drop down selection enables you to specify the format of the TimeStamp in the Data 

Decode panel. The screenshot below shows the Time dropdown menu. In this example, the format selected 

is HH:MM:SS.ms.us.ns(.ps) which shows demicals down to the picoseconds. 

 

This next example shows the TimeStamp shown in Nano-Seconds. 
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Frames 

If you selected to Extract Video Frames when running the capture, the button to access the Frames tab will 

be enabled, as shown below. 

 

Click this to access the Frames tab, which is shown below. Depending on the Buffer Size specified, there 

will be more or less frames to view. The example below is  a 1.000% buffer size, which extracted two video 

frames in this case. 

 

This next example is a 4.000% buffer size, which extracted 10 video frames. 
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From this tab you can open the Video Image Viewer by double clicking any frame. This pop out panel is 

shown below. 

 

Once in the Video Image Viewer, you can scale the image and toggle on or off the colorimetry panel (CIE 

Plot). The previous image was scaled to 1:1, and the following example is scaled to fit. The colorimetry 

panel is also enabled on the left-hand side of the panel.  

You can also navigate to the Previous or Next image frame, or move to an adjacent pixel using the arrows 

at the bottom of the panel. 

  

Navigate Frames      Move Pixels 
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Event Plot Panel 

The Event Plot is shown below. The Event Plot provides a graphical view of the captured data symbols. 

The vertical axis is the data types. In this example the Data, CSB, Errors, and Markers rows are enabled. 

The scale along the bottom shows the Link Clock number. 

 

The timestamp of the cursor is shown near the top of the panel. As you move the pointer tool throughout the 

Event Plot panel the timestamp of the pointer’s location is provided on the top of the panel as indicated 

below: 

 

Scrolling in the Event Plot Panel 

A scroll bar is provided to enable you to quickly browse through the data. The scroll bar is under the set of 

function icons just above the data panel where the data is displayed. You can also scroll to the end, scroll by 

page or scroll incrementally in either direction using the  backward and forward activation 

 buttons located to the right of the scroll bar. 

You can also click and drag the panel in either direction if Pan Mode is enabled. Click the hand icon  at 

the top left of the Event Plot Panel to enable click and drag in Pan Mode. 
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Zooming in the Event Plot Panel 

You can zoom in and zoom out and pan across the data using the slide bars provided. You can also zoom 

by surrounding a specific section of the captured data. These functions are described in the following table. 

Even Plot Zoom Icons Function 

Zoom Icons 

 

Previous  – This icon reverts the Event Plot Panel to the previous view. 

This will effectively “undo” a zoom or scroll. 

Range Zoom   – This function zooms in on a selected range within the 

Event Plot. Details below. 

Zoom In/Out icons  – The Zoom In/Out function buttons enables 

you to zoom in and zoom out by clicking on the activation button. The 

centered point will remain the same. 

 

 

Surrounding and Zooming 

The Event Plot provides a Range Zoom tool . You can select an area of the Event Plot by clicking and 

dragging across. When you do this the new view will be limited to the horizontal range that you selected. 

The midpoint of the selection will become the new center of the data displayed. The following screen shows 

an example of the Range Zoom Mode. The rectangle indicates the resultant section that is surrounded. 
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The resulting screen is as follows:  

 

 

Working with Markers 

The Event Plot panel enables you to view the data at a high level and identify points of interest for further 

analysis. You can set two cursors or "markers" at particular points of interest using the Markers activation 

button . The Event Plot will show you the time difference between the two cursors. Note the example 

below. 
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You can fine tune the position of the markers with the left and right arrows associated with each marker:  

You can also deselect and remove a marker by unchecking its respective box. 

The center icon allows you to center the particular marker on the center of the Event Plot window. 

The example below shows Marker 2 deselected/removed and the Event Plot centered on Marker 1. 

 

You can see the timestamp associated with each marker which are color coded (blue and red) just above 

the area where the data is shown. The dark text to the right labeled Dif shows the difference between the 

two markers in pixels and time. 

 

Note: You can also set an individual marker using the right click menu shown below. 

 

  

v 
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Link Clock timeline. 

The Link clock symbol times are shown at the bottom of the Event Plot panel as indicated below. 
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Data Decode Panels 

The Data Decode Panel is shown below. The Data Decode panel provides a tabular or transactional view 

of the captured data symbols. When you highlight a transaction the information in the transaction appear in 

the Details panel to the right. The information in the Details panel is decoded in human readable text. 

The example below shows an Audio Stream data type highlighted. 

 

The next example below shows the details panel of an MSA data type highlighted. 
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Link Symbol Panel 

The Link Symbol Panel is shown below. The Link Symbol Panel provides an event list of all the raw link 

symbols in the capture for each lane. The data for each lane is presented in a separate column. 

When you double click on a link symbol, the offset is reset to zero at that link symbol and the other two 

panels are then synchronized to that that point in the capture. The Link Symbol that is synchronized to is 

presented at the top of the panel as indicated below. The same occurs when a data type is selected in either 

of the other two panels. 
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The Find button enables you to search for any type of control element. The Find dialog box is shown below 

with the Blanking Start (BS) control element selected. You can then search through the Link Symbol panel 

for all occurrences of that symbol or any other using the PREVIOUS and NEXT buttons within the Symbol 

Search box.  

 

You can select up to 8 symbols to search for.  

The Goto button enables you to snap to a specific Symbol number. When Absolute is selected, you will 

enter the exact Link Symbol number to find.  

 

When Relative to Zero is selected, the function finds the Link Symbol relative to the Link Symbol with 

Offset of +0. Negative and Positive numbers are both accepted in this mode.  

Note: If the Symbol # entered (either Absolute or Relative to Zero) is out of bounds, the GOTO button will be 

grayed out and unclickable. 
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UHD/Multi-Stream Transport Captures 

When performing a capture in Multi-Stream Transport mode, the Capture Viewer will display the main link  

capture data within the Event Plot Panel, as shown below. 

Note: For information on Multi-Stream Transport modes, see 3.6 Topology and Multi-Stream Transport.   

 

To access the desired virtual channel and its captured data, use the Open VC button enabled in the top right 

of the window, as shown below.  

 

The Open a Virtual Channel dialog box will appear. Select the desired virtual channel you wish to view, and 

click OK, as demonstrated below. 

 

Main Link  
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Upon selecting a virtual channel, the DP VC Viewer will present the specified virtual channel and the data 

will be available for viewing, as described previously in this section.  

You can easily return to the Main Link capture viewer by clicking the Main Link button, or open a different 

virtual channel by clicking the Open VC button as well, both in the top right of the window (pictured below) 

The example shown below has virtual channel 3 selected.   
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 Searching and Filtering for Specific Data Elements 

You can locate data items by browsing either through the Event Plot view of the Event Data table. The two 

windows (Event Plot and Event Table) are in sync as you browse, search or select an item.  

Event Search 

You can locate specific data types using the Event Search feature in either the Event Plot or the Event 

Table. The following screen shot is a typical example of captured data. The Event Search dialog box is 

accessible from the Find activation button on the top of the DP Capture Viewer window as shown 

below. 
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The Event Search dialog box is shown below. You can search for specific data types using the tabs and the 

check boxes within each tab. This example has MSA Secondary Packet data type selected for search. 

 

The dialog box enables you to select all or none of the data element types per category using the Select All 

or Select None buttons on the top of the dialog box, as shown below.  

There are several tabs on the sidebar. Each tab enables you to select from a category of data types. You 

can click Deselect All Categories to uncheck all data types in every tab. 

 

Select as many or few data types as you need to find.  
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Once you have selected your desired data types, click the NEXT button to move to the first result. The 

results of a search are shown at the bottom of the dialog box, under Results, as shown below. This example 

searches for the VSC data type. Note that the Count is an indication of the number of that data element that 

appears in the captured data. 

 

This next screenshot is the same search, after pressing the NEXT button one more time and proceeding to 

the next occurrence of the VSC data type.  
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In the following example, the Trigger condition Marker is searched for. Note that the status of the search is 

shown on the bottom of the dialog box. The search function centered the trigger condition marker on the 

Event Plot which you can partially see behind the dialog box. Since the panels are synchronous, the trigger 

marker is also selected in the Data Decode and Link Symbol panels.  

 

Note: If the Count column shows a count of greater than zero, but clicking NEXT yields the message No 

Events Found (example below), you may be ahead of that occurrence, and need to click the PREVIOUS 

button instead. 
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The following example shows a search of audio packets.  
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Filtering Specific Data Elements 

You can filter the captured data to show only specific data types using the Event Selection feature. The 

Event Selection dialog box is accessible from the Events activation button on the top of the DP 

Capture Viewer window as shown below, with the DP Event Selection window on the right.  
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The following screen shows an example of filtering for an MSA Secondary Packet. Check the box next to the 

data type you wish to filter, and click OK. The results of the filter apply to both the Event Plot and the Event 

Data panels. 

 

The results of the filter for MSA data elements on the Event Plot and Event Table panels are shown below. 
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Similarly to the Find dialog box, you can Select or Deselect All Categories with the buttons at the top of 

the dialog box. The categories are listed in the left-hand column. You can also Select All or Select None 

within an individual category. The example below has opted to Select All within the KChar category. 

 

The following screen shows the results of the filter. 
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 Importing, Exporting, and Transferring Capture Files 

This section describes the Import, Export, and Transfer features of the M42d. 

The Import and Export options on the right-click menu and the Navigator sidebar allow you to exchange 

capture files between your PC or a USB Drive and the ATP GUI Manager application. 

You may Export a capture file to disseminate to colleagues or other subject matter experts. You import a file 

when you want to examine a capture file taken by a colleague or transferred from USB storage. The Export 

and Import function zips or unzips a capture file to enable you to post it on an FTP server or disseminate 

through email of the file is not too large. 

The Transfer feature enables you to simply transfer a capture file executed on the M42d embedded GUI 

onto your PC’s ATP Manager for viewing/analysis, or vice versa. The Transfer feature is only accessible 

from the Remote ATP Manager on a PC since you need a remote PC to execute the transfer. 

You may Transfer a capture file to back up your captures to your PC from your instrument and vice versa. 

You also need to transfer a capture in this manner in order to view it remotely if you originally ran the 

capture on the M42d embedded ATP Manager. 

All of these features are accessible through the Navigator interface on the instrument or the remote 

manager. 

Exporting a Capture File 

To export a capture file, navigate to its folder in the ATP Manager Navigator interface by clicking Captures 

and expanding the folder(s) that it is contained in. An example below shows capture files stored in the User 

folder on a PC running the remote ATP Manager. 
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Click on a capture file, and export by selecting the Export button on the left sidebar, or right-clicking and 

selecting Export, both shown below. 

  

When you select Export, a File Explorer window will show up enabling you to save the capture as a zip file 

in a directory and name of your choosing. Refer to the screen example below. 

Note: If you are on the M42d instrument itself, the file explorer window will be Linux-based. 
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Choose a desired directory and filename, and click Save. This capture file will then be accessible in a file 

explorer as a compressed zip file, as shown below. 

 

Importing a Capture File 

Similarly, to import a file, in the Navigator either right click on the desired target folder, or select the folder 

and click the Import button at the bottom left of the window. The example below demonstrates importing a 

capture file into the User folder. 
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A File Explorer window will appear enabling you to navigate to the directory where you have stored your 

zipped capture file. Select the file and click Open as shown below. 

 

 

You will then be given an opportunity to rename the file with the Import DP Capture dialog box as shown 

below. Click OK once you have the desired name for the import. 
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You will see a confirmation dialog box and you the new capture will appear in the list of captures in the 

Navigator panel as shown below. 
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Transferring a Capture File Between Instrument and Remote PC. 

To Transfer a file, use the Navigator interface to select the folder on the remote PC that you wish to transfer 

to/from. Click the Transfer button on the left sidebar. An example below shows a Transfer with the User 

folder selected. 

 

The Data Transfer: DP Capture dialog box will appear, as shown below. 
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To transfer a capture file from the PC to the Instrument, select the file in the left-hand column labeled Local 

Files. Next, click on a target folder in the righthand column labeled Instrument Files. At this point you may 

either Copy the file to the instrument or Move it—which removes the file from the local storage on the PC. 

The example below shows copying the file DP_Capture_2 from the PC onto the Instrument’s User folder. 

 

The result is the DP_Capture_2 file now appearing in the Instrument Files column as well, as shown below. 

Note: If the Move>> transfer option is utilized, the file will not appear in both directories, only the target 

folder on the instrument, as mentioned earlier. 
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To transfer a file from the Instrument to the Local Host, select a file from the Instrument Files column, and 

a target folder from the Local Files column, and click Copy or Move to transfer. The following example 

shows the file 00DP_Capture_3 being moved from the Instrument to the PC. 

  

The result is shown below. Notice the file is no longer contained within the User folder of the Instrument 

Files. 

 

Note: If a file in the target folder already has the same name as the file you are attempting to transfer, the 

Copy and Move buttons will not be enabled. You will need to rename the capture first using the Rename 

button at the bottom of the dialog box.  
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6 Auxiliary Channel Analyzer (ACA) 

The Auxiliary Channel Analyzer (ACA) utilities enable you to view the DDC and aux channel traffic for 

DisplayPort streams in real time or from stored real time log files. For DisplayPort, you can view the HDCP 

authentication transactions, EDID exchanges, Link Training transactions, side band messages, Multi-Stream 

Transport negotiations, etc. in real time with the ACA either through the embedded ATP GUI Manager or the 

external ATP GUI Manager application running on a host PC.  

You can view the transactions between the M42d 80G Video Analyzer/Generator, generator ports and a 

connected DP display device and you can monitor the transactions between the M42d’s analyzer port and a 

connected DP source device.  

There are three (3) Auxiliary Channel Analyzer utilities: 

▪ Auxiliary Channel Analyzer (“ACA”) – Used for real time viewing auxiliary channel DisplayPort 

Aux Chan data through the ATP GUI Manager. You can also open existing ACA trace files stored on 

the M42d Instrument. 

▪ ACA Remote Control - Used for viewing auxiliary channel DisplayPort data through the ATP GUI 

Manager. This application operates in sync with the Aux Channel Analyzer on the embedded 

display. 

▪ ACA Data Viewer - Used for viewing previously captured auxiliary channel data. You can view these 

saved ACA traces and disseminate them to colleagues at other locations. These colleagues can 

then use the ACA Data Viewer utility off-line without a M42d test instrument to view these 

transactions. 

 Accessing the Auxiliary Channel Analyzer (ACA) 

Use the following procedures to monitor the DisplayPort Aux Chan transactions with a DisplayPort device in 

real time. The procedures assume that the DP device under test is powered up and connected to one of the 

M41d ports. The operation of the ACA is the same when testing a source or a sink. 

The operation of the two ACA real time utilities—Aux Channel Analyzer on the connected external HDMI 

display and the ACA Remote Control on the ATP GUI Manager running on the host PC is similar, though 

both are covered in this section.  

Accessing the Auxiliary Channel Analyzer on the embedded M42d GUI 

For the ACA utility, Select the Aux. Channel Analyzer app. 
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The Aux Channel Analyzer panel appears as shown below: 

 

The following table describes the ACA Control menu, located at the top of the window in the above 

screenshot. This is just a brief overview, as detailed instructions on certain features here will be described in 

following sections. 

There is a menu associated with the ACA Info panel. It is location on the right side of the panel. The 

ACA pull-down menu provides the following functions: 

/  
Starts and Stops the collection of DDC data 

/  

Halts the updates of the data to the ACA panel to view traces and allows you 

to resume. 

 
Clears the ACA Trace Panel.  

 

Opens up the ACA Event Selection window. This feature is described in 

detail later in this section. 
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Opens up the Options dialog box. Described in detail later in this section. 

 

Pauses the Trace Panel on the selected event. With Scroll Lock off, the 

Trace Panel will continue to move in order to display the most recent event. 

 

▪ File – Opens flyout menu with Open and Save options 

▪ Open – Open a previously saved ACA file 

Save – Save current trace locally 

 

Navigates you back to the Home menu screen of the M42d ATP GUI 

Manager. 

 
Navigates back to the previous screen in the Real Time mode. 

 
Takes you to the Navigator interface 

 
Closes out the ACA application. 
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Accessing the Auxiliary Channel Analyzer Remote Control on a PC 

This subsection describes the ACA Remote Control utility used for viewing the real time DisplayPort Aux 

Channel transactions through the ATP GUI Manager.  

ACA Remote Control – Panel Description 

The ACA Remote Control panel application is available only on the ATP GUI Manager. It enables you to 

collect and view the ACA transactions in real time from a remotely connected PC with the ATP GUI Manager 

application. A screenshot of the Remote Control window is below. Notice there are a few slight differences 

from the embedded GUI, which are detailed in the table below. 

 

There are a few differences between the ACA window on the embedded M42d GUI and the ACA 

Remote Control on a PC. These changes are outlined below. 

 

Connect to your test instrument. Will either connect automatically (if you have 

just one instrument in ATP Manager), or offer you to select a device to 

connect to. 

 

▪ Save – drops down Save flyout menu 

▪ Save to Instrument – allows you to save the current ACA Trace to 

the M42d itself 

▪ Save to PC – allows you to save the current ACA Trace to the host 

PC  
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Drop-down menu allowing you to change text size of the window 

 Monitoring Auxiliary Channels with Aux Channel Analyzer Utilities 

This section describes the procedures for monitoring the auxiliary channel data through the ATP GUI 

Manager using the Aux Channel Analyzer real time utilities—both the Aux Channel Analyzer utility available 

through the M42d ATP GUI Manager or the ACA Remote Control utility available through the external ATP 

GUI Manager running on a PC. You can monitor the DisplayPort transactions in real time when module is 

emulating a DisplayPort source device. If you have the M42d Rx Analyzer port you can emulate a 

DisplayPort sink device to test a DisplayPort source device. 

Use the following procedures to monitor the DisplayPort Aux Chan transactions with a DisplayPort device in 

real time. The procedures assume that the DP device under test is powered up and connected to one of the 

M41d ports. The operation of the ACA is the same when testing a source or a sink. 

The operation of the two ACA real time utilities—Aux Channel Analyzer on the connected external HDMI 

display and the ACA Remote Control on the ATP GUI Manager running on the host PC is similar. The 

screen examples used in this subsection are from the ACA Remote Control utility on the ATP GUI Manager 

exceptions related to the operation of the ACA on the ATP GUI Manager running on the connected external 

HDMI display are noted. 

To monitor the DisplayPort transactions: 

1. Access the Aux Channel Analyzer / ACA Remote Control (depending on the display method for the 

ATP Manager GUI). 

2. If you are using the ACA Remote Control on a host PC, first connect to the desired instrument, as 

shown below. 
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3. Specify which DP events you wish to monitor using the EVENTS button in the control menu, as shown 

below. 

  

The ACA Event Selection dialog box will appear, as shown below. 

 

4. Select the ports and events you wish to monitor. Refer to the table below for options. 

 
Select all events on all ports 

 
Deselect all events on all ports  

 Deselect all events only on the selected port 

 Select events on the M42d’s Generator simulated Tx port 

 

Select events on the M42d’s Protocol Analyzer simulated 

Rx port 

 Select events on the connected DP or USB-C Tx port 
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 Select events on the connected DP or USB-C Rx port 

 

5. Specify which DP events you wish to monitor. You can select All Events of any set of individual events. 

In the following example, the user has selected All Events (on all ports), which is the default selection. 

Important Note: You can filter and search through the ACA traces after the data collection has 

completed, as well. Procedures for searching and sorting are provided in a separate subsection further 

below. 

 

In the next example, the user has selected to monitor only DP events on the DP/USB-C Tx Out port.  
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6. Touch select the Start button on the ACA Control Menu at the top to initiate the viewing of the DP Aux 

Chan transactions.  

7. Take the necessary action—such as a hot plug—to initiate EDID, HDCP or Link Training transactions. 

You will see the Aux Chan transactions in the ACA panel as shown below. 

An example showing monitored data is shown below. You can stop or pause the collection at any time 

using the buttons on the ACA Control Menu. 
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The next subsection will break down the ACA Window in more detail. It is very similar to the ACA Data 

viewer utility, which will also be covered.  

8. Once you have finished running the trace, click on Save to Instrument or Save to PC depending on 

whether you are working with the external ACA Remote Control utility or the embedded Aux Channel 

Analyzer. A dialog box appears (below). Enter a name and then click on OK. 

 

Please note: 

▪ In order to use the ACA Data Viewer utility (Section 6.4) on your PC to view the traces or the ACA 

viewer on the ATP GUI Manager running on the external display with the powerful searching and 

filtering features, you must save the file, as shown in the previous step.  

▪ If you are working on the Aux Channel Analyzer viewer but prefer to use ACA Data Viewer on the 

external ATP GUI Manager, you will have to transfer the saved file to your PC using the ATP GUI 
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Manager running on the external display. This is covered in 6.5 Importing, Exporting, and 

Transferring ACA Data. 

▪ You can also passively monitor ACA transactions while testing both a source and sink device. 

Instructions for this procedure are in Chapter 7 Passive Monitoring.  
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 ACA Window and Panel Description 

The ACA Window will display the trace details from the data collection executed in the previous section. An 

example of a populated ACA window is below. Note the top toolbar remains unchanged from when first 

opening the Aux Channel Analyzer. 

 

You can access the Options dialog box using the top Control menu. Options menu items are described in 

the following table: 

Options Dialog Box 

 

▪ Scroll Lock – Locks the left-hand trace panel to the selected 

event. When this is off, the panel will continuously scroll with 

the most recent event. 

▪ Show Port Name – Enables you to display or not display the 

Port name (the Port number is always shown). 

▪ Show Time-stamp – Enables you to show or not show the 

time stamps for each transaction. 

▪ Show Time-deltas – Enables you to show the time stamps 

relative to the previous transaction. Only available when 

Time-Stamps are shown (see above). 

▪ Set Zero Time – Enables you to set a log record to zero. 

Subsequent log records are relative to this new zero time 

record. 

▪ Reset to Zero Time – Resets the initial record in the active 

log in the ACA Trace window to zero. 
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The ACA Trace Panel displays each event in a row with some information. This information is expanded in 

the ACA Event Details panel which will be covered next. An example of the ACA Trace Panel is below. The 

numbered arrows correspond to the descriptions immediately following the screenshot. 

 

1. Item number – This is a unique sequence number of the transaction.  

2. Type – The type of Aux Chan transaction; either EDID, HDCP DPLT (Link Training), DNAT (DP native Aux 

transactions), etc. 

3. Port Name and Number – Port Name is an optional viewing field. Port Number will always be displayed. 

4. Time stamp (optional viewing field) – Shows the timestamp of each transaction. Can either be absolute time 

based (shown) on the M41d system clock or relative time (Time-deltas) referenced from the initial transaction 

in the trace. 

5. Transaction Description – A brief description of the transaction. 

  

1 

2 

3 

4 

5 
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The ACA Event Details Panel will display the details of the selected transaction within the trace panel, as 

shown below. This screenshot is of details for a Link Training transaction. 

 

The following list describes the information that is provided in the ACA Event Details dialog box. 

Note: The information in the Details panel will vary depending on the type of log record that is selected. 

▪ Start Time – This the start time of the transaction in microseconds from a reference time determined 

when the capture of real time data began. 

▪ Type – There are various types of data that can be monitored on the DisplayPort interfaces: EDID, 

HDCP and DP specific data types related to Link Training, side band messaging, Multi-Stream Transport 

transactions, native transactions, etc. 

▪ Direction – The direction of the transaction either a request or a reply. 

▪ Command – The type of Command being issued 

▪ Address – The register address of the transaction 

▪ Details (text) – The contents of the transaction in human readable text. 

Details (hex) – The contents of the transaction in hex data. 
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There are some control arrows and a status panel on the bottom of the ACA Event Details panel, as shown 

below.  

The left and right arrows allow you to navigate to the immediately previous or following transaction.  

The Status Field to the right shows the sequence number and the description of the selected transaction. 

 

 ACA Data Viewer 

This subsection describes the ACA Data Viewer utility used for viewing DisplayPort Aux Channel 

transactions that have been stored on the PC hosting the ATP GUI Manager. You can use the ACA utility on 

the ATP GUI Manager to view ACA trace files stored on the M41d itself. The operation of the two ACA 

utilities is similar. The screen examples used in this subsection are from the ACA Data Viewer utility but the 

general operation is similar to the embedded version. 

Please note that in order to use the ACA Data Viewer utility on your remote PC to view the traces or the 

ACA viewer on the M42d ATP GUI Manager display with the powerful searching and filtering features, you 

must save the file.  

If you are working on the embedded Aux Channel Analyzer viewer but prefer to use ACA Data Viewer on 

the external ATP GUI Manager, you will have to transfer the saved file to your PC using the external ATP 

GUI Manager. Instructions for transferring are detailed in the next section. 

ACA Data Viewer – Panel Description 

Access the ACA Data Viewer by selecting the Other tab on the home screen and clicking the ACA Data 

Viewer icon, as shown below. 
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You’ll notice the window looks similar to the ACA Utility, though there are a few distinct and very useful 

additions. A screenshot of the populated ACA Data Viewer is below. Notice the Trace Panel and Event 

Details Panel are the same as described in 7.3 ACA Window and Panel Description. 

 

The main difference is in the Control Menu at the top of the window. The following are features not found in 

the ACA Utility: 

▪ Open – Open a file saved locally, whether on the instrument or host PC  

▪ Filter – Filter results shown in the Trace Panel 

▪ Find – Find a specific data type in the Trace Panel 

▪ Export – Export results as text or html file 
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To load an ACA Data set, click the Open button in the control menu. The Open ACA Data dialog box will 

appear, as shown below. 

Select the data set you would like to open, and then click OK. 

 

The resulting populated ACA Data Viewer is shown in the example below. Notice the Trace Panel and Event 

Detail Panel are identical to the view while monitoring in the ACA Utility itself. 
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Exporting ACA Data as Text or HTML File 

The Export feature allows you to export the current ACA Data Set as either a text or HTML file and save it 

locally to the hard disk. 

The following table features a screenshot of the Export as… dialog box. In this example, All events have 

been selected. 

Export Dialog Box 

 

Field Description 

Events Enables you to select all recorded events, or a 

specified range 

Start Field available only when Range radio button is 

active to specify the first record of the range of 

records to include in the export operation 

End Field available only when Range radio button is 

active to specify the last record of the range of 

records to include in the export operation. 

Show Time Delta Toggle enabling you to export the data with the time 

showing as relative to the previous event 

Show Details Toggle enabling you to export the data and include 

the human-readable information in the Event Details 

Panel 

Show Raw Data Toggle enabling you to export the data and include 

the raw data 

File Format Enables you to select between Text or HTML file 

export 

 

Once you have selected the desired options, choose a folder to save the file in, and click Save. 

This data will then be accessible in any program that is capable of reading .txt or .htm files. 
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Using the ACA Filter Feature 

The ACA Filter dialog box is accessible using the Filter button. The ACA Filter function enables you to filter 

an ACA trace file to view a subset of the log records in a particular data set.  

The ACA Filter feature is only available within the ACA Data Viewer. If you wish to use the Filter feature on 

ACA traces that you have captured using the ACA Remote Control (remote PC) or Aux Channel Analyzer 

(embedded GUI), you have to save the ACA data and reload it through the ACA Data Viewer utility. 

See 7.2 Monitoring Auxiliary Channels with ACA Utility for instructions on saving an ACA Data set. 

 

Filtering Data 

You access the ACA Filter function using the Filter button on the control menu at the top of the ACA Data 

Viewer window.  

 

The ACA Filter dialog box appears, as shown below. 

 

  



M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 171  July 18, 2021 

 

There are four tabs within the dialog box, as well as a control toolbar at the top. Each tab will be covered in 

detail within this subsection, along with examples. 

Note that criteria may be selected and combined amongst all four filtering options if so desired. 

The following table gives an overview of the Control Menu at the top of the dialog box: 

ACA Filter – Control Menu 

 

Button Function Description 

Open Opens a stored user-created 

Filter configuration. 

You can store commonly used filter configurations 

using the Save function and recall them for quick 

access using the Open button. Save Saves the current user-

created Filter configuration. 

Clear Clear the existing Filter 

criteria. 

You can build up complex filter configurations by 

combining multiple filter criteria. When you add 

multiple configurations, they behave as a logical OR 

function whereby if either of the criteria is True, the 

filter function will filter an entry. 

You enter criteria through the embedded touch screen 

with a pop-up keypad in the ACA real time utility or 

simply by typing on the external ATP GUI Manager 

interface.  

When you are assembling filter configurations you can 

clear individual configurations by highlighting them in 

the panel provided and then use the Clear button. You 

can add through the Add button. You can remove an 

individual configuration using the Remove button. 

Example screen shots are shown below. 

Add  Sets the currently defined 

Filter criteria defined in either 

the Source, Type, Label or 

Details sub-panels and adds 

another row for a new filter 

criterion. 

Remove Removes a highlighted filter 

criterion of an existing filter 

configuration. 

 

  



M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 172  July 18, 2021 

 

Filter by Source 

The following screenshot demonstrates the Source tab within the ACA Filter dialog box. A description is 

following the image. 

 

The Source tab features checkboxes to select the port on a particular module that you want to filter. Please 

note that you can collect data in the ACA Trace window from multiple ports. 

When you select multiple Source ports they behave as a logical OR function. 

When you initiate a search, the Filter function will locate all records matching the criteria. If only the Source 

(port) is specified, all records from or to that source will be highlighted. 

Filter by Type 

The following screenshot demonstrates the Type tab within the ACA Filter dialog box. The Type tab 

consists of check boxes enabling you to specify which data types you wish to filter for. When you select 

multiple data types they behave as a logical OR function. 
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Filtering by Label 

The following screenshot demonstrates the Label tab within the ACA Filter dialog box. A description is 

following the image. 

 

The Label tab is used for specifying criteria for text that appears in the Label field of the event log. When 

you enter a criterion in the Label field, it will automatically be added to the set of criteria in the panel above it. 

▪ Text Contains – A toggle to activate the Label criteria. 

▪ NOT – A checkbox which when checked will filter for records that do not meet the criteria in the field 

beneath it. 

▪ Text Field – A text field to enter a string that will be matched (or not matched). NOTE: This text field 

is case sensitive. 

▪ Regular Expression Syntax – A check box to specify whether the text in the Text Field will be treated 

as plain text or a regular expression. Regular expression syntax is a commonly used set of operators 

for filtering the text. You can find detailed examples on the web including Wikipedia. If Regular 

Expression checkbox is checked, you can enter in any regular expression into the text field for a 

string match. 

The following example filters for an event with “Precharge” in its label (result on the left): 
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Filtering by Detail 

The following screenshot demonstrates the Detail tab within the ACA Filter dialog box. A description is 

following the image. 

 

The Detail tab is used for specifying criteria for text that appears in the Details field of the event log. When 

you enter a criterion in the Detail field, it will automatically be added to the set of criteria in the panel above 

it. 

The fields and functionality in this panel are the same as the Label tab (see above). 

The following example filters for events that do NOT contain the word “LANE” (the field is case-sensitive). 

The results are on the left-hand side within the ACA Data Viewer Trace Panel. 

Note that the Event counter above the Trace Panel shows how many events are within the filter, followed by 

the total number of events in the unfiltered trace in parentheses. 
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Using the ACA Find Feature 

The ACA Find dialog box is accessible using the Find button. The ACA Find function enables you to quickly 

locate different types of events.  

The ACA Filter feature is only available within the ACA Data Viewer. If you wish to use the Filter feature on 

ACA traces that you have captured using the ACA Remote Control (remote PC) or Aux Channel Analyzer 

(embedded GUI), you have to save the ACA data and reload it through the ACA Data Viewer utility. 

See 7.2 Monitoring Auxiliary Channels with ACA Utility for instructions on saving an ACA Data set. 

A screenshot of the ACA Find dialog box is below. Note that the Find dialog box is similar in appearance to 

the Filter dialog box. 

Finding Specific Data 

You access the ACA Find function using the Find button on the control menu at the top of the ACA Data 

Viewer window.  

 

The ACA Find dialog box appears, as shown below. 
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There are four tabs within the Find dialog box, as well as a control toolbar at the top. Each tab will be 

covered in detail within this subsection, along with examples. 

Note that criteria may be selected and combined amongst all four finding options if so desired. 

The following table gives an overview of the Control Menu at the top of the dialog box: 

 

ACA Filter – Control Menu 

 

Button Function Description 

Open Opens a stored user-created 

Find configuration. 

You can store commonly used find configurations 

using the Save function and recall them for quick 

access using the Open button. Save Saves the current user-

created Find configuration. 

Clear Clear the existing Find 

criteria. 

You can build up complex find configurations by 

combining multiple find criteria. When you add multiple 

configurations, they behave as a logical OR function 

whereby if either of the criteria is True, the search will 

find an entry. 

You enter criteria through the embedded touch screen 

with a pop-up keypad in the ACA real time utility or 

simply by typing on the external ATP GUI Manager 

interface.  

When you are assembling find configurations you can 

clear individual configurations by highlighting them in 

the panel provided and then use the Clear button. You 

can add through the Add button. You can remove an 

individual configuration using the Remove button. 

Example screen shots are shown below. 

Add  Sets the currently defined 

Find criteria defined in either 

the Source, Type, Label or 

Details sub-panels and adds 

another row for a new find 

criterion. 

Remove Removes a highlighted find 

criterion of an existing find 

configuration. 

 

The bottom of the dialog box features a PREVIOUS and NEXT button. These will take you to the next or 

previous match of the find criteria within the Trace Panel. Use these to navigate the events that were found 

matching the desired criteria. 
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Find by Source 

The following screenshot demonstrates the Source tab within the ACA Find dialog box. A description is 

following the image. 

 

The Source tab features checkboxes to select the port on a particular module that you want to find. Please 

note that you can collect data in the ACA Trace window from multiple ports. 

When you select multiple Source ports they behave as a logical OR function. 

When you initiate a search, by clicking on the Next or Previous button, the Find function will locate a record 

matching the criteria. If only the Source (port) is specified, the next or previous record from or to that source 

will be highlighted. 

Find by Type 

The following screenshot demonstrates the Type tab within the ACA Find dialog box. The Type tab consists 

of check boxes enabling you to specify which data types you wish to find. When you select multiple data 

Types they behave as a logical OR function. 
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The following example demonstrates a search for all events of type DP-Native. The result of clicking NEXT 

once DP-Native has been checked appears on the left-hand side within the ACA Trace Panel. 

 

Clicking NEXT again would take the Trace Panel to the next DNAT data type on line 25. 

 

Finding by Label 

The following screenshot demonstrates the Label tab within the ACA Find dialog box. A description is 

following the image. 
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The Label tab is used for specifying criteria for text that appears in the Label field of the event log. When 

you enter a criterion in the Label field, it will automatically be added to the set of criteria in the panel above it. 

▪ Text Contains – A toggle to activate the Label criteria. 

▪ NOT – A checkbox which when checked will find records that do not meet the criteria in the field 

beneath it. 

▪ Text Field – A text field to enter a string that will be matched (or not matched). NOTE: This text field 

is case sensitive. 

▪ Regular Expression Syntax – A check box to specify whether the text in the Text Field will be treated 

as plain text or a regular expression. Regular expression syntax is a commonly used set of operators 

for finding the text. You can find detailed examples on the web including Wikipedia. If Regular 

Expression checkbox is checked, you can enter in any regular expression into the text field for a 

string match. 

The following example retains the previous criterion (type DP-Native), but searches for a label with text 

containing “ACK.” Note the top right panel which lists all criteria for the search.  
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Finding by Detail 

The following screenshot demonstrates the Detail tab within the ACA Find dialog box. A description is 

following the image. 

 

The Detail tab is used for specifying criteria for text that appears in the Details field of the event log. When 

you enter a criterion in the Detail field, it will automatically be added to the set of criteria in the panel above 

it. 

The fields and functionality in this panel are the same as the Label tab (see above). 

The following example retains the previous two criteria (DP-Native data type and “ACK” in the label), but 

searches for events that contain the text “DPCD” (the field is case-sensitive). 

The ACA Find dialog box is below and the result of the search in the ACA Data Viewer window follows. 

Note the top right panel which lists all the criteria for the search. 
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 Importing, Exporting, and Transferring ACA Data 

This subsection will describe the following processes in detail: 

▪ Export of an ACA Data file to a file folder or USB storage 

▪ Import of an ACA Data file from a local file folder or USB storage 

▪ Transfer of an ACA Data set from an M42d instrument to a remote host PC or vice versa. 

All of these features are accessible through the Navigator interface either on the instrument itself or through 

the remote ATP Manager. 

Exporting an ACA Data File 

To export an ACA data file, navigate to its folder in the ATP Manager Navigator interface by clicking ACA 

and expanding the folder(s) that it is contained in. An example below shows ACA data files stored in the 

User folder on a PC running the remote ATP Manager 
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Click on an ACA data file, and export by selecting the Export button on the left sidebar, or right-clicking and 

selecting Export. Both shown below. 

 

When you select Export, a File Explorer window will show up enabling you to save the capture as a zip file 

in a directory and name of your choosing. Refer to the screen example below. 

Note: If you are on the M42d instrument itself, the file explorer window will be Linux-based. 
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Choose a desired directory and filename, and click Save. This capture file will then be accessible in a file 

explorer as a compressed zip file, as shown below. 

 

Importing a Capture File 

Similarly, to import a file, in the Navigator either right click on the desired target folder, or select the folder 

and click the Import button at the bottom left of the window. The example below demonstrates importing an 

ACA Data file into the User folder. 
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A File Explorer window will appear enabling you to navigate to the directory where you have stored your 

zipped capture file. This can be a local file on the PC/Instrument itself or a USB storage drive. Select the file 

and click Open as shown below. 

 

A dialog box will appear, instructing you to choose a destination name. The contents of the zipped folder will 

be unzipped to a new folder with this name. This is the same as naming an ACA Trace file when saving in 

the ACA Remote Control (PC) or Aux Channel Analyzer Utility (M42d) 

Choose the default, or type in a destination name for the ACA Data, then click OK. 

 

The ACA Data file folder will now appear in the folder that you imported into. 
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Transferring and ACA Data File Between Instrument and Remote PC. 

You can view ACA traces using the ACA viewer off-line on your PC with the ACA Data Viewer utility. In 

order to view the ACA files on your PC with the ATP GUI Manager application you will first have to transfer 

them to the PC using the Data Transfer utility. 

The ability to save ACA traces enables you to disseminate them to other subject matter experts for analysis 

or to Teledyne customer support. You can view the ACA traces without a M41d test instrument once you 

have transferred the files to your PC.  

Note: Transferring files must be done on a host PC that is connected remotely to an M42d instrument. 

 

Transferring ACA Data Files 

To Transfer a file, use the Navigator interface to select the folder on the remote PC that you wish to transfer 

to/from. Click the Transfer button on the left sidebar. An example below shows a Transfer with the User 

folder selected. 
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The Data Transfer: ACA Data dialog box will appear, as shown below. 

 

To transfer a capture file from the PC to the Instrument, select the file in the left-hand column labeled Local 

Files. Next, click on a target folder in the righthand column labeled Instrument Files. At this point you may 

either Copy the file to the instrument or Move it—which removes the file from the local storage on the PC. 

The example below shows copying the file Aux_Channel_Analysis from the PC onto the Instrument’s User 

folder. 
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The result is the Aux_Channel_Analysis file now appearing in the Instrument Files column as well, as 

shown below. 

Note: If the Move>> transfer option is utilized, the file will not appear in both directories, only the target 

folder on the instrument, as mentioned earlier, and shown in the next example. 

 

 

To transfer a file from the Instrument to the Local Host, select a file from the Instrument Files column, and 

a target folder from the Local Files column, and click Copy or Move to transfer. The following example 

shows the file SampleACAdata1 being moved from the Instrument to the PC’s user folder. 
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The result is shown below. Notice the file is no longer contained within the User folder of the Instrument 

Files. 

 

Note: If a file in the target folder already has the same name as the file you are attempting to transfer, the 

Copy and Move buttons will not be enabled. 
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7 Passive Monitoring 

Passive Monitoring, or Passive Probing, is a licensed feature of the M42d. The M42d allows the user to 

place the instrument between a DP1.4/2.0 source and a DP1.4/2.0 Sink and monitor the video information 

passing through the unit using the Protocol Analyzer as well as performing regular and ACA captures. Note 

that HDCP video content cannot be displayed or captured. 

Passive Monitoring enables the user to perform the following functionality: 

▪ Use the Basic Analyzer dashboard to view all the video data passing through in real time 

▪ Use the ACA to perform capture of Aux Channel data 

▪ Perform regular data capture of the data passing through using the Capture Control Protocol 

Analyzer. 

 Connecting a DisplayPort Source and Sink Device Under Test 

This procedure describes how to connect a source and a sink device to the M42d for Passive Monitoring. 

Connections can be made to the M42d via native high quality 8K DP cables (one meter or less) or the USB-

C cables provided.  

The following procedure will provide for a stable connection. Use the diagram below as a guideline. Note 

that this diagram shows connections only to the USB-C ports. Alternatively, you can use the DisplayPort 

connectors up to 10G lane rates. But you must use the same type ports (DP or USB-C) on each side. 
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Note: During passive monitoring of HDCP protected content, only the external source and sink devices 

participate in the encryption. The Passive-mode Analyzer does not have access to the encryption key and 

therefore cannot display the transported video. 

To connect your source and sink DUT to the M42d: 

1. Open the “Real Time” Receiver (Basic Analyzer) window of the embedded ATP (running on the 
externally connected display connected to the HDMI admin port in back). 

2. Click on the Passive Monitoring button and ensure it is Off. 
Note: You cannot do this step from the External ATP Manager running on a PC. 

 

3. Connect your source to the M42d Rx port of your choice (either USB-C or DisplayPort) with the 
appropriate cable to your source device. 

4. Configure your source device to output a DisplayPort video stream. 

5. In the case of USB-C cable connections, make sure that the cable connections are correct. The port 
status LED should be Green and you should see the video on the external display connected to the 
M42d HDMI admin port. Flip the USB-C cable at the M42d if the status LED is Red. 

6. Connect a cable to the M42d Tx port with the appropriate cable (DisplayPort or USB-C that you used to 
connect from your source device) to the display device. 

7. Configure the M42d to generate a DIsplayPort signal. 

8. In the case of USB-C cable connections, verify that the cable connections are correct. The port status 
LED should be Green and you should see the generated video on your Sink display device. Flip the 
USB-C cable at the M42d if the status LED is Red. 

9. Once you have verified that the status LED’s on the ports are Green (Note this LED does not indicate 
the orientation during Passive Probing)  
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Enable Passive Probing 

You can now enable Passive Probing by turning On Passive Monitoring through the Basic Analyzer window 
as shown below. 

 

Important Note: In the passive-probing mode, you may need to generate a hot plug by physically 

disconnecting/connecting only the cable between Source and the M42d Rx port.  

The cable between M42d Tx port and Sink must remain connected. 
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 Passively Viewing Video Data in Real Time 

The Basic Analyzer provides real time view of the monitored source video and metadata including status of 

mainstream attributes, secondary data attributes, link training, Multi-Stream Transport, and HDCP. 

Passive Monitoring using the Rx Analyzer real-time viewer is similar to the procedures outlined in Chapter 4 

Source Verification with Basic (Real-time) Analyzer. Refer to that chapter if necessary for more in-depth 

coverage of this process. 

Accessing Basic Analyzer Features 

From the Home screen of the M42d ATP Manager, select the DisplayPort/USBC 2.0 Protocol Analyzer 

Rx app, as shown below.  

 

The Analyzer panel appears showing the passed-through video image. The M42d’s Basic Analyzer provides 

periodic video frame captures of the source video, enabling you to view frames of video. This feature 

provides a basic confidence test to verify that the passed-through video is essentially correct. 
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Basic Analyzer Dashboard 

This subsection describes the dashboard components on the top of the Basic Analyzer panel. Refer to the 

table below for a description of these components. 

Basic Analyzer – Dashboard Items 

Example dashboard of DisplayPort 2.0 Protocol Analyzer Rx in Passive Monitoring mode. 

Example using USB-C DP-alt mode in Passive Monitoring mode with DSC enabled and active. 

 

Note: The Source and Sink devices must both be connected to the same type of port (USB-C or DP) for Passive 

Monitoring to work. 

  The following items are on the Real Time dashboard: 

Top Row Items – Module and Port: 

▪ Port  - The Port area shows the current Rx port that 

is being displayed on the Basic Analyzer. Currently the only analyzer port is the Video Generator port. 

Second Row Items: 

▪ Monitor  - Indicates the HDCP encryption of the monitor. 

Note: If unencrypted, this will be the indicator:  

▪ LTTPR Emulation  - Indicates whether LTTPR emulation is active 

▪ Passive Monitor  – Indicates that passive monitoring is enabled.  

Third Row Items: 

▪ Measured  or - Indicates whether USB-C or DP (DisplayPort) is 

currently connected. 

▪ Lanes  - The number of lanes used during link training. 

▪ Bandwidth  - The link rate (per lane). 

▪ Active (video resolution)  - This is the measured video resolution. 

Note: If DSC is active this will be indicated . 

▪ V-Total  - This is the measured total vertical video lines per frame. 

▪ VRate - This is the measured vertical frame rate 

Fourth Row Items: 

▪ Res  - The active video resolution in horizontal pixels and vertical lines determined 

from the main stream attributes. 

▪ Total  - The total video in horizontal pixels and vertical lines determined from the 

main stream attributes. 
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Basic Analyzer – Dashboard Items 

▪ Sync  - Horizontal sync pulse width (in pixels) and polarity, followed by vertical sync 

pulse width (in lines) and polarity. (e.g. Hsync 88 pixels, positive; Vsync 10 lines, positive) 

▪ Start  - The starting pixel and line in the active video determined from the main stream 

attributes. 

▪ Colorimetry and bit depth  - The colorimetry and bit depth determined from 

the main stream attributes. 

▪ Scan  - The scan type used, progressive (e.g. Prog) or interlaced (Inter) determined from 

the main stream attributes. 

Fifth Row Items: 

▪ Sync-Clk  - Indicates if the Link Clock and Main Video Stream clock are asynchronous or 

synchronous. A value of N means async; a value of Y means synchronous. This value is determined by the 

main stream attributes. 

▪ Stereo-3D  - The status of 3D audio determined from the main stream attributes. 

▪ Mute  - The AudioMute flag status determined from the main stream attributes. 

▪ Vfreq  - Video frequency determined from the main stream attributes. 

▪ Afreq - Audio frequency determined from the main stream attributes. 

Sixth Row Items: 

▪ Pixel Clock  - How often pixels occur (frame rate x pixels per frame) 

▪ DwnSp  - DownSpread indicates whether Spread Spectrum Clocking (SSC) is enabled 

▪ HDCP-Enc  – Indicates if HDCP encryption is currently active 

 

For a more in-depth look at the Rx Analyzer, see section Chapter 4 Source Verification with Basic (Real-

time) Analyzer. Real-time analysis with the Basic Analyzer is functionally similar to these procedures while 

in Passive mode.  
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 Passively Monitoring ACA Transactions 

The Auxiliary Channel Analyzer (ACA) utilities enable you to view the DDC and aux channel traffic for 

passively monitored DisplayPort streams in real time. For DisplayPort, you can view the HDCP 

authentication transactions, EDID exchanges, Link Training transactions, side band messages, Multi-Stream 

Transport negotiations, etc. in real time with the ACA utility.  

In Passive Monitor mode, you can view the transactions between the connected DP source device and a 

connected DP display device.  

Passively Monitoring the Auxiliary Channel Transactions  

To passively monitor the Aux Channel transactions: 

1. Access the Aux Channel Analyzer, as demonstrated below.  

 

2. Specify which DP events you wish to passively monitor using the EVENTS button in the control menu, 

as shown below. 

  

The ACA Event Selection dialog box will appear, as shown below. 
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3. Select the ports and events you wish to monitor. Refer to the table below for options. 

Note: In Passive Monitoring, you will only want to monitor transactions on the DP 2.0/USB-C Tx Out and Rx 

In (bottom two ports listed), not the Generator or PA Rx (top two ports listed). 

 Select all events on all ports 

 
Deselect all events on all ports  

 Deselect all events only on the selected port 

 

Select events on the M42d’s Generator simulated Tx port 

(not used in Passive Monitoring)  

 

Select events on the M42d’s Protocol Analyzer simulated 

Rx port (not used in Passive Monitoring) 

 Select events on the connected DP or USB-C Tx port 

 Select events on the connected DP or USB-C Rx port 

4. Specify which DP events you wish to passively monitor. You can select All Events of any set of 

individual events. In the following example, the user has selected All Events (on all ports), which is the 

default selection. 

Important Note: You can filter and search through the ACA traces after the data collection has 

completed, as well. Procedures for searching and sorting are provided in 6.4 ACA Data Viewer. 

In this example, the user has selected to passively monitor only DP events on the DP/USB-C Tx Out 

port.  
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5. Select the Start button on the ACA Control Menu at the top to initiate passive monitoring of the passed-

through Aux Chan transactions.  

6. Take the necessary action—such as a hot plug—to initiate EDID, HDCP or Link Training transactions 

between the connected source and sink devices. You will see the passed-through Aux Chan 

transactions in the ACA panel as shown below. 

An example showing passively monitored data is shown below. You can stop or pause the collection at 

any time using the buttons on the ACA Control Menu. 

 

Section 6.3 breaks down the ACA Window in more detail. It is very similar to the ACA Data viewer 

utility, which is also be covered.  

7. Once you have finished running the trace, click on Save to Instrument. A dialog box appears (below). 

Enter a name and then click on OK. 
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Please note: 

▪ In order to use the ACA Data Viewer utility (Section 6.4) on your PC to view the traces or the ACA 

viewer on the ATP GUI Manager running on the external display with the powerful searching and 

filtering features, you must save the file, as shown in the previous step.  

▪ If you are working on the Aux Channel Analyzer viewer but prefer to use ACA Data Viewer on the 

external ATP GUI Manager, you will have to transfer the saved file to your PC using the ATP GUI 

Manager running on the external display. This is covered in 6.5 Importing, Exporting, and 

Transferring ACA Data. 

ACA Window and Panel Description 

The ACA Window will display the trace details from the data collection executed in the previous section. An 

example of a populated ACA window is below. Note the top toolbar remains unchanged from when first 

opening the Aux Channel Analyzer. 
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You can access the Options dialog box using the top Control menu. Options menu items are described in 

the following table: 

Options Dialog Box 

 

▪ Scroll Lock – Locks the left-hand trace panel to the selected 

event. When this is off, the panel will continuously scroll with 

the most recent event. 

▪ Show Port Name – Enables you to display or not display the 

Port name (the Port number is always shown). 

▪ Show Time-stamp – Enables you to show or not show the 

time stamps for each transaction. 

▪ Show Time-deltas – Enables you to show the time stamps 

relative to the previous transaction. Only available when 

Time-Stamps are shown (see above). 

▪ Set Zero Time – Enables you to set a log record to zero. 

Subsequent log records are relative to this new zero time 

record. 

▪ Reset to Zero Time – Resets the initial record in the active 

log in the ACA Trace window to zero. 

 

 

The ACA Trace Panel displays each event in a row with some information. This information is expanded in 

the ACA Event Details panel which will be covered next. An example of the ACA Trace Panel is below. The 

numbered arrows correspond to the descriptions immediately following the screenshot. 

 

1 

2 

3 

4 

5 
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1. Item number – This is a unique sequence number of the transaction.  

2. Type – The type of Aux Chan transaction; either EDID, HDCP DPLT (Link Training), DNAT (DP native Aux 

transactions), etc. 

3. Port Name and Number – Port Name is an optional viewing field. Port Number will always be displayed. 

4. Time stamp (optional viewing field) – Shows the timestamp of each transaction. Can either be absolute time 

based (shown) on the M41d system clock or relative time (Time-deltas) referenced from the initial transaction 

in the trace. 

5. Transaction Description – A brief description of the transaction. 

The ACA Event Details Panel will display the details of the selected transaction within the trace panel, as 

shown below. This screenshot is of details for a Link Training transaction. 

 

The following list describes the information that is provided in the ACA Event Details dialog box. 

Note: The information in the Details panel will vary depending on the type of log record that is selected. 

▪ Start Time – This the start time of the transaction in microseconds from a reference time determined 

when the capture of real time data began. 
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▪ Type – There are various types of data that can be monitored on the DisplayPort interfaces: EDID, 

HDCP and DP specific data types related to Link Training, side band messaging, Multi-Stream Transport 

transactions, native transactions, etc. 

▪ Direction – The direction of the transaction either a request or a reply. 

▪ Command – The type of Command being issued 

▪ Address – The register address of the transaction 

▪ Details (text) – The contents of the transaction in human readable text. 

Details (hex) – The contents of the transaction in hex data. 

 

There are some control arrows and a status panel on the bottom of the ACA Event Details panel, as shown 

below.  

The left and right arrows allow you to navigate to the immediately previous or following transaction.  

The Status Field to the right shows the sequence number and the description of the selected transaction. 
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 Passively Analyzing Video Data using Capture Control 

The Capture Control utility allows the user to capture and store passed-through data of the main link 

protocol, video, and metadata—including main stream attributes and secondary data—from a passively 

monitored DP connection. 

Use the following procedure to capture passively monitored video data using the Capture Control utility. 

Verifying Source Video 

Before you capture passively monitored video data, you should verify that you are properly receiving the 

passed-through DisplayPort video from the source. 

Verify the incoming video of the DisplayPort source to ensure that the source is outputting the proper video. 

In the screen example below the video shown is a test pattern. Typically, the video you will see will be from 

a PC or some other source device. Verify the information in the top status bar, and that Passive Monitor is 

on, as shown below. 
  

  

w 
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Capture Control Panel 

Access the Capture Control app from the Home Screen of the ATP Manager interface. 

You initiate a new capture of passively monitored data through the Capture Control panel. The Capture 

Control panel enables you to setup the capture parameters. The figure below shows the Capture Control 

panel and its control and selection items. 

 

The following table describes the functions of the Capture Control panel, specifically the Data tab: 

Capture Control Panel - 

Function 

Item - Description 

Buffer Size • Enables you to set the size of the captured data in percent.  

• This is a slidebar that provides an indication (on the left) of the 

percent of the total possible size to be captured. A lower value will 

require less time for the captured data to accumulate. 

Trigger Position within Buffer • Enables you to set the position of the trigger event within the 

captured data.  

• This slidebar determines how much of the data that has 

accumulated in the capture buffer has occurred before the trigger 
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Capture Control Panel - 

Function 

Item - Description 

event. The slidebar has an indication (on the left) of the location of 

the trigger event within the captured data. The value is expressed as 

a percent.  

• A value of 0% indicates that the trigger event occurs at the 

beginning of the resulting captured data and 100% indicates that the 

trigger event occurs at the end of the resulting captured data.  

• A value of 50% indicates that the trigger event is in the middle of the 

captured data. 

• Note: The Buffer Position Slidebar is not applicable when you select 

Vsync as the trigger condition. 

Trigger Mode  

 
• Enables you to specify the type of data that you want to capture. 

• Note: This is covered in greater detail later in this section 

Trigger Count • Option to specify which occurrence of the selected trigger event will 

initiate capture 

• eg. a Trigger Count of 5 will start capture at the 5th occurrence of the 

trigger event 

Extract Video Frames • Enables you to view the video frames that were captured. 

Decompress DSC Frames  • Makes video frames viewable if DSC mode is enabled 

• Extract Video Frames toggle must be enabled for this option to be 

active 

Capture AUX (ACA) 

Transactions 
• Enables you to capture the Aux Channel transactions 

Start Capture (Capture Tab) • Initiates a capture using the criteria defined in the Trigger Mode 

and Trigger Symbol. 

The Trigger Mode drop down selection allows you to pick the specific event occurrence that will initiate the 

capture. You may use the radio buttons to select a trigger at Any Rate or Non-UHBR Only 
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With the Any Rate radio button selected, a set of options is selectable from the drop-down menu beneath it, 

as shown below and described in the following table: 

Any Rate Trigger Mode Drop Down Menu Trigger Options 

 

• Start of vertical blanking (SST) or SR/LLCPM 

symbol (Multi-Stream Transport) 

• SDP Type Received 

• SDP Type Not Received 

• VB-ID Received 

• VB-ID Not Received 

• AUX Read or Write (Only Writes in Passive Mode) 

• Start of TPS2 as indicated by DPCD 0x00102 

• Exit from TPS2 as indicated by DPCD 0x00102 

• Start of HDCP 2.2 (N/A in Passive Mode) 

• Exit from HDCP 2.2 (N/A in Passive Mode) 

 

When selecting Non-UHBR Only Trigger, another set of options is selectable from the drop-down menu 

beneath it. A few of these triggers require you to select the lane for the trigger to occur on, as shown and 

described in the table below.  

Non-UHBR Only Trigger Mode Drop Down Trigger Options 

 

If Specified Symbol is selected then select one of: 

• BS=Blanking Start 

• BE=Blanking End 

• BF=Blanking Fill 

• C0-C7=VC Payload Fill Control code sequence 

• CP=Content Protection 

• FE=Fill End, FS=Fill Start 

• R0-2 

• SE=Secondary Data End 

• SR=Scrambler Reset, 

• SS=Secondary Data Start 

• Other 
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• Data Byte Value 

• 8B10B Symbol Error 

• 8B10B Disparity Error 

• Start of TPS3 as indicated by DPCD 0x00102 

• Exit from TPS3 as indicated by DPCD 0x00102 

• Start of TPS4 as indicated by DPCD 0x00102 

• Exit from TPS4 as indicated by DPCD 0x00102 

• Start of HDCP 1.3 (N/A in Passive Mode) 

• Exit from HDCP 1.3 (N/A in Passive Mode) 

• FEC Decode Enable Sequence 

• FEC Decode Disable Sequence 

• ML_PHY_STANDBY detected on main link 

• ML_PHY_SLEEP detected on main link 

• AUX_PHY_WAKE detected on AUX channel 

 

The next subsection will describe the procedures for passively capturing and viewing data using Capture 

Control. 
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Capturing Passed-through Displayport Video Data 

1. Access the Capture Control application from the ATP Manager home screen. 

The Capture Control window opens as shown below. 

 

2. Select the port using the Select  activation button as shown below. 

3. Specify the Buffer Size and Trigger Position, Mode, and Count in accordance with the information 

provided earlier in this chapter. 

4. Toggle on or off the options to Extract Video Frames, Decompress DSC (if applicable), and Capture 

AUX (ACA) Transactions. 

5. Initiate the capture by clicking on the Start Capture activation button 
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You will be prompted with a New Capture dialog box (below) given you an opportunity to assign a name 

to the capture file. 

 

6. Enter a name in the space provided in the New Capture dialog box. 

Click OK to begin the capture process. A progress bar will appear, as shown below.  

If the capture trigger event does not occur, you may click the MANUAL TRIGGER or STOP AND SAVE 

DATA buttons. They are described below. You can also CANCEL the capture at any time. 

▪ Manual Trigger – If the trigger event does not occur as expected, or if you are viewing the video 

display in real time and you notice an occurrence that you would like to capture the data of, manually 

initiate a capture with the previously set specifications at this point. 

▪ Stop and Save Data – If the capture is not triggered as expected, you can essentially cancel the 

capture and keep the raw data for later analysis.  

 

Once the capture trigger event has occurred, the data will be decoded and saved for viewing. An 

example of the progress bar while this occurs is below. 
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When the capture is complete, the data is presented in the DP Capture Viewer. An example of the captured 

data is shown in the screen shot example below.  

 

The Capture Viewer and its features/functionality are covered in much detail in sections 6.4 Capture 

Viewer Panels (covers the Event Plot, Data Decode/Details, and Link Symbol panels) and 6.5 Searching 

and Filtering for Specific Data Elements (searching for events or symbols, and filtering using the functions 

within the Capture Viewer).  
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8 LTTPR Testing 

All LTTPR testing features are licensed. More information about licenses can be found in Appendix A. 

Licenses. 

 Overview 

The M42d supports the testing of LTTPR-capable source devices and also provides link layer transaction 

data for LTTPR devices and a DPRx sink.  

Two revisions of LTTPR are supported, revisions 14h and 20h. Revision 14h is for non-transparent mode or 

transparent mode for LTTPR in an 8b/10b network. Revision 20h is used when testing LTTPRs in non-

transparent mode in UHBR networks. 

While testing a source device in the non-transparent mode, each LTTPR is trained in the link. This ensures 

better signal quality to the end-to-end link. When testing an LTTPR-capable source device, the M42d can 

emulate a network of up to 8 LTTPR devices and a DPRx (sink).  

The M42d can also generate video to LTTPR device(s) as a DPTx (source). 
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 LTTPR Emulation for Testing Source Devices 

The tool you will use for LTTPR emulation is located within the Protocol Analyzer Rx interface, accessible 

from the Home screen of the M42d’s embedded ATP Manager GUI. 

To access the LTTPR utility, click the Tools icon in the control menu on the right-hand side of the Receiver. 

This will display the Tools dialog box. Click the LTTPR tab on the left sidebar to access the utility, as 

demonstrated below. 

 

The LTTPR emulation tool appears as shown above. Using this tool, you can emulate up to eight LTTPR 

devices. This tool offers options for configuring the emulated LTTPR, and more configurations are available 

within the DPCD Editor, which is covered in the next section. 
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To emulate LTTPR for testing a source device, first select the version of LTTPR according to your testing 

specification, as shown below. 

 

Notice that with version 14h selected, the adjustable UHBR options within the LTTPR tool for do not apply to 

non-UHBR emulation. These are enabled with version 20h in UHBR mode, as shown below. 

 

If emulating LTTPR version 20h (non-transparent LTTPR), modify the values of the adjustable fields in 

accordance with your testing specifications.  
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For example, in the screenshot below, the source device will read that the emulated LTTPR8 is not set due 

to the user-configured override value of 7F in the bottom-most field. 

 

Note: Any adjustments to these settings must be done with the Emulated TPPR Count set to Off. Once an 

LTTPR count has been set, the M42d begins emulating LTTPR and the settings cannot be changed without 

again turning emulation off. 
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Once you have adjusted these fields per your testing requirements, select the number of LTTPR devices 

you wish to emulate. The following example has selected an LTTPR count of 4. 

 

As mentioned previously, notice that the adjustable fields are now disabled, as emulation has begun.  

In order to re-enable adjustment of these fields and re-activate LTTPR: 

1. Turn off emulation by clicking the Off button. 

 

2. Make adjustments to desired fields in LTTPR Tool 

3. Re-enable LTTPR emulation by selecting desired LTTPR Count. 
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 Modifying LTTPR Capability Registers 

Once the M42d has begun LTTPR emulation, you can modify the DPCD of the emulated Rx LTTPR device 

to further meet your testing specifications. To do this, access the DPCD Editor utility within the Editors tab 

of the Home screen, as shown below. 

 

This takes you to the DPCD Editor. From there, navigate to the LTTPR tab on the left-hand sidebar, as 

demonstrated below. 
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The window displays tabs for each LTTPR Capability Register that can be changed. To display the registers 

for the current Rx being emulated by the M42d, click Read Rx in the top right corner of the window. A 

loading bar will appear while the Rx DPCD is read, as shown below. 

Note: The LTTPR emulation demonstrated in the previous section must be enabled for the registers to 

correctly to populate field values other than zero. LTTPR off will display zero for all field values. 

 

 

The DPCD Editor will now display the LTTPR Capability Registers with their current field values. The 

example below is emulating LTTPR 2.0 (20h). Major Revision value is 2, Minor Revision value is 0. 
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These capability registers are configurable to be able to emulate different LTTPR configurations. A full list of 

the registers is listed in Appendix B. Configurable LTTPR Capability Registers. 

To modify the configuration, select the LTTPR register you wish to change, as shown below. This example 

has selected the F0006h MAIN_LINK_CHANNEL_CODING_PHY_REPEATER register. The currently 

emulated configuration supports 128b/132b coding. 

  

Edit the fields that you wish to re-configure according to your testing specifications. Furthering the previous 

example, the user has disabled support for 128b/132b coding using the drop-down menu, as demonstrated 

below. 
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Additionally, continuing with the example, the user would select F0007h 

PHY_REPEATER_128B/132B_RATES and disable support for all UHBR rates, as shown in the following 

sample screenshots. 
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Once you have configured the LTTPR Capability Registers to your testing specifications, click on Write Rx 

in the top corner, and the M42d’s receiver will update its emulated LTTPR with the modified DPCD. 

 

A dialog box (example pictured below) may appear with warning messages regarding the M42d’s simulated 

Rx. This can be ignored when testing a source device and writing a configured DPCD to the M42d as an Rx. 

 

The emulated LTTPR will now reflect the newly configured LTTPR capabilities. 
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In the previous screenshot, the user has navigated back to the M42d Receiver and the dashboard is still 

reading as 4 LTTPR being emulated.  

In this specific example, the M42d Rx still supports LTTPR version 2.0, emulating 4 LTTPR. However, based 

on the DPCD editing, the emulated LTTPR only supports up to 8.10 Gbps link rate and will not support any 

UHBR rates or 128b/132b coding. The source is forced into transparent 8b/10b LTTPR link training at a rate 

of up to 8.10 Gbps.  

Note: Configured LTTPR capabilities using the DPCD Editor have to be reapplied anytime the LTTPR is 

reset/modified and reenabled from the Rx Analyzer Tools menu. Instructions for saving and quickly 

reapplying user modified register configurations are in the following subsection.  
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Saving and Opening/Reapplying Saved LTTPR Configurations 

As stated in the previous section, the DPCD and LTTPR Capability Registers reset to the specifications 

given in the LTTPR tab of the Tools Menu within the Rx Analyzer. Any manually reconfigured capability 

registers will be overwritten with DPCD of the newly enabled Rx and emulated LTTPR. 

The M42d offers the ability to save and open a modified DPCD (including LTTPR Capability Registers) to 

quickly reapply these configurations when LTTPR is reset or reenabled from the Rx Analyzer Tools menu. 

For example, a user can configure the DPCD according to their test specifications and save the DPCD, then 

recall the DPCD any time they start or restart a test session. 

The procedure for this process is as follows: 

Saving DPCD 

1. Once you have the configurations you would like to save within the DPCD Editor, click Save at the top of 

the window. 

 
 

2. A Save dialog box will appear. Select the desired path, type in a name for the new DPCD, and click OK, 

as shown below. 

  
The DPCD is now saved in the User folder. 



M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 223  July 18, 2021 

 

With the configured DPCD now saved, you can open apply this DPCD at any time from the DPCD 

Editor. In the following example, the user will enable LTTPR with slightly modified settings using the 

LTTPR Tool within the Analyzer Rx, as demonstrated in the first section of this chapter. 

 

Note: Keep in mind through the next several steps that when loading a custom DPCD, LTTPR must 

already be emulating. If you begin LTTPR emulation after loading the custom DPCD, the DPCD 

registers will be reset to the default configurations for the given emulation. 

 

Reset LTTPR Emulation 

3. Navigate to the LTTPR Tool within the Analyzer Rx.  

LTTPR Emulation should still be active, as shown below. 

 
 

4. Turn off LTTPR emulation. 
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5. Make the desired adjustments to the emulated LTTPR within this Tools dialog box, and resume LTTPR 

emulation. In the following example, the LTTPR version has been switched to 1.4 and there are now 8 

emulated LTTPR. 

 
Upon reactivating LTTPR emulation, the DPCD will revert to the settings applied in this step using the 

Analyzer Rx LTTPR Tool. 

 

6. To verify this, navigate to the DPCD Editor and click Read Rx. 

 
After reading the Rx DPCD, the first LTTPR Capability register will display as version 1.4, as shown 

below. 
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Open/Reapply Previously Saved DPCD 

7. To restore the previously set and saved LTTPR capabilities, open the saved DPCD file by clicking the 

Open button at the top of the DPCD Editor window. 

 
 

8. An Open dialog box will appear. Select the desired DPCD file and click OK  

 
 

Once the DPCD has loaded, the file name will appear at the top of the window, as shown below. Notice 

as well that the first LTTPR Capability Register displays the previously configured Field Values for the 

LTTPR version number being emulated by the Rx. 

 
 

The example within this subsection was a rudimentary change to the DPCD’s LTTPR Register, but 

demonstrated the capability to save and open custom DPCDs when dealing with LTTPR. This gives the 

user the ability to pick up where they left off with previous configurations when beginning a new testing 

session. 

A full list of the configurable LTTPR Capability Registers within the DPCD Editor can be found in 

Appendix B. Configurable LTTPR Capability Registers. 
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 Testing LTTPR Devices with M42d as DPTX 

The M42d also has the capability to test and read the ability of one or multiple LTTPR devices to link train 

with a Tx source. 

The negotiated transactions can be viewed within the ACA Utility. Detailed instructions for executing an Aux 

Channel trace are provided in Chapter 6 Auxiliary Channel Analyzer. This section will cover using the 

ACA utility with one or multiple LTTPR devices. 

Note: This is a separately licensed capability. More information on licenses can be found in Appendix A. 

Licenses. 

Monitoring Link Training Negotiations with LTTPR(s) 

This subsection outlines the procedures for monitoring the link training transactions between the M42d 

instrument acting as a source and up to eight LTTPRs between source and sink. 

With the LTTPR devices properly connected, open the ACA Utility or ACA Remote Control. The screenshot 

examples in this section are of the ACA Remote Control operating on a remote host PC, though the 

operation is similar to that of the ACA Utility on the embedded GUI ATP Manager of the M42d. 

1. Connect to the correct M42d instrument if using the ACA Remote Control, and click START to begin 

monitoring the aux channel transactions. 
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2. Navigate to the Tools tab within the Generator application. From there, select Link Train from the left-

hand sidebar. 

 

 

3. Within the Link Train tool, select a Lane Count and a Link Rate according to your desired testing 

specifications, as shown below. Link training will automatically occur at the selection of a Link Rate. 
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4. Once link training is complete, return to the ACA Utility or ACA Remote Control and click STOP to end 

the ACA trace. 

 

Note: To use the more robust features of the ACA Data Viewer, including finding and filtering for 

specific event types, see Chapter 6 Auxiliary Channel Analyzer (ACA) for detailed instructions on 

saving trace files and accessing the ACA Data Viewer. 

5. Within the Trace Panel, scroll to the appropriate event to view the LTTPR capabilities read during Link 

Training. A few of the capabilities demonstrated in the following example are displayed within the Event 

Details panel as follows: 

▪ LTTPR version 2.0 (value for Major Revision 2, Minor Revision 0)  

▪ Max Link Rate value is 1Eh (8.1 Gbps per lane) 

▪ LTTPR Count value is 10h (4 LTTPRs) 

▪ LTTPR Mode value is AAh (Non-transparent LTTPR) 
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Reading DPCD Registers with LTTPR(s) Present 

As discussed in Chapter 3 Generator, you can view the DPCD of a connected sink. The DPCD Viewer has 

the capability of reading connected LTTPR devices as well. 

Navigate to the DPCD Viewer tool within the Generator application and Tools tab. 

Select the LTTPR Registers from the left sidebar and click READ PAGE or READ ALL. From here you will 

be able to see the capabilities and configurations similar to what was monitored within the ACA Utility in the 

previous subsection. 

A brief example below shows the results of reading the DPCD with the DPCD Viewer. 
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9 Panel Replay Testing 

 Overview 

The M42d’s supports basic testing of Panel Replay-capable source devices. This feature provides the 

following: 

▪ Basic emulation through the DPCD 

▪ The ability to capture the Panel Replay VSC packets in Capture Control to show the selective 

updates to frames 

▪ Viewing of the Panel Replay VSCs in the Basic Analyzer window 

▪ Viewing of the Auxiliary transactions for querying the Panel Replay capabilities in the DPCD 

 

Note: Panel Replay testing is a licensed feature. Information on specific licenses can be found in Appendix 

A. Licenses 

 Emulation through the DPCD 

The following DPCD registers are implemented in support of Panel Replay. 

▪ PANEL REPLAY CAPABILITY SUPPORT registers (DPCD address 00B0h-0B4h 

▪ PANEL REPLAY ENABLE, AND CONFIGURATION registers (DPCD address 001B0h)  

▪ PANEL REPLAY STATUS registers (DPCD address 002004h – 0020024h)  

 

You can configure the DPCD registers to emulate support for Panel Replay, as shown in the following 

screenshot example. 
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 Viewing Panel Replay VSCs in Basic Analyzer window 

The M42d offers the ability to view the Panel Replay VSCs within the real time Basic Analyzer. 

Use the following procedures to view the Video Stream Configuration data while testing a Panel Replay-

capable source DUT. 

Open the Basic Analyzer from the Home Screen. More information on the Basic Analyzer can be found in 

Chapter 4 Source Verification with Basic Analyzer. 

Access the VSC information window by clicking the VSC button in the right-hand control menu within the 

Analyzer. The VSC window will appear within the Analyzer, as demonstrated below. 
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The VSC window contains information about Panel Replay. Note the PR State and selective updates fields 

in the VSC packet example below. 

 

 

You may also utilize the Filter drop-down menu to view the Panel Replay VSC packets in real time, as 

demonstrated below. 
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 Capturing Panel Replay VSC Packets 

The M42d offers the ability to capture VSC packets in the Protocol Analyzer. A Panel Replay Active trigger 

mode is available within the Capture Control utility, as shown below. 
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After executing the capture, the Virtual Channels within the Capture Viewer show the VSC packets and the 

selected update regions. Note the selective updates fields in the Event Details panel of the selected VSC 

packet. 
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 Viewing Panel Replay Auxiliary transactions  

ACA decoding has been implemented for all Panel Replay DPCD registers. When a source DUT makes a 

connection to the M42d, you can monitor the Aux Channel to verify that the source reads the Panel Replay 

DPCD registers as shown below. 

Note: For procedures for using the M42d’s ACA utility, including running an analysis and finding/filtering for 

specific events, see Chapter 6 Auxiliary Channel Analyzer. 

The following example shows an Aux Channel Analysis in which the source DUT confirms that Panel Replay 

capability is supported by the M42d’s emulated Rx. 
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10 eDP 

The M42d 80G Video Analyzer/Generator supports several eDP features such as fast link training, alternate 

scrambler seed, Advanced Link Power Management (ALPM) and backlight control through control pins. A 

pin header is available to provide access to the backlight Tx control test feature. The M42d offers the 

hardware necessary to support a variety of optional eDP features. 

Note: The eDP features are optional and require purchase of a license to activate. 

eDP Pin Configurations 

1. BL_Enable (Possible Future Rx input) 
2. BL_Enable (Tx Output) 
3. BL_PWM_DIM (Possible Future RX input) 
4. BL_PWM_DIM (TX Output) 
5. Ground 
6. Ground 

 

 

 

 

 

 eDP Testing Connections 

This section provides procedures on how to connect your eDP TCON panel or graphics source system to 

the M41d HBR3 Video Analyzer/Generator. You will use the Standard DisplayPort connectors for testing 

eDP (not the USB-C connectors). You will need an eDP to DP adapter cable and or an adapter board to 

make these connections. 

 
eDP Source Test Connections 
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eDP Sink Test Connections 

 Fast Link Training 

This section provides procedures on eDP fast link training. Once the fast link training has been achieved the 

Source or Sink test features supported by the M42d 80G Video Analyzer/Generator can be used. 

Fast Link Training – Source Tests 

Use the following procedure to test eDP fast link training on an eDP source device. 

1. Navigate to the Rx Analyzer/Receiver from the Home screen of the M42d ATP Manager GUI 
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2. Within the Basic Analyzer, select the Tools button on the control menu, then select the eDP tab on the 

left-hand side of the Tools dialog box, as shown below. 

 

3. Enable eDP and Fast Link Training using the Enabled buttons indicated below: 

 

4. Select to enable or disable Spread Spectrum according to your test requirements. 
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5. Select to Fast Link Training Lane Count and Link Rate according to your test requirements. 

 

 

Fast Link Training – Sink Tests 

Use the following procedure to test eDP fast link training on an eDP sink device. 

1. Access the Fast Link Training controls from the Generator panel and the Tools tab. 

 

2. Select the Fast Train tab on the right as indicated by the arrow on the above screen shot. 

The Link Train window shows the Current Status in the top panel, and the control options within the 

bottom panel. 
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3. Toggle on or off Spread Spectrum, Synchronous Clock, and FEC (Forward Error Correction) at the 

top of the window according to your test requirements, as demonstrated below 

 

 

4. Select the Lane Count, Link Rate, Voltage Swing, Pre-Emphasis and the Test Pattern in accordance 

with your eDP test requirements. See below. 
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5. Click on the Fast Train button to initiate the link training. Then click on the Refresh button, as shown 

below 
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Fast Link Training – Monitoring the Fast Link Training Transactions on the Aux Channel 

Refer to the ACA section Monitoring the DisplayPort auxiliary channels with the ACA utilities for 

procedures in monitoring the eDP fast link training and ALPM Aux Channel transactions associated with the 

eDP negotiations. A sample screen shot is shown below. 
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 Advanced Link Power Management (ALPM) 

This section provides procedures on testing eDP ALPM on eDP source and sink devices. 

ALPM – Source Tests 

Use the following procedure to test eDP ALPM on an eDP source device. 

1. Navigate to the Rx Analyzer/Receiver from the Home screen of the M42d ATP Manager GUI. 

 
 

2. Within the Rx Analyzer, Select the Tools button on the control menu, then select the ALPM tab on the 

left-hand side of the Tools dialog box, as shown below. 
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3. Within this window, view the States diagram on the top of the Tools panel and the State Transaction 

History at the bottom.  

Note: You may need to zoom in or out on the diagram, which can be done using the magnifying glass 

icons at the bottom right of the panel  as shown above 

 

ALPM – Sink Tests 

Use the following procedure to test eDP ALPM on an eDP sink device. 

1. Access the ALPM controls from the Generator panel and the Tools tab, as shown below. 

 

2. Select the ALPM button on the left indicated by the arrow on the above screen shot. 

The ALPM window shows the current state on the left side of the panel. 

3. Select the activation buttons on the right side of the window underneath Press to Cause Event to cause 

transitions to the various ALPM states. 
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The following table describes the ALPM Activation function buttons. 

ALPM State Transition Buttons 

Activation Buttons Function 

Disable AV Stream 

 

Disables the streaming of audio and video over the main link. The 

link is trained and the source is sending either an idle pattern or a 

ML_PHY_LOCK pattern. Causes a transition to the 1a state: Active 

NoStream.  

Enable AV Stream 

 

Enables the streaming of audio and video over the main link. The 

link is trained and the source is sending an AV stream. Causes a 

transition to the 1 state: Active.  

Disable Main Link 

 

Disables the Main Link. 

Enable Main Link 

 

Enables the Main Link. 

Set DPCD Sleep 

 

Puts the ALPM sink in the Sleep state by writing to DPCD registers 

over the Aux Channel.  

Set DPCD Wake 

 

Puts the ALPM sink in the Wake state by writing to DPCD registers 

over the Aux Channel. 

ML Phy Sleep 

 

Puts the ALPM sink in the Sleep state by sending K-character 

sequence over the Main Link. 

ML Phy Standby 

 

Puts the ALPM sink in the Standby state by sending K-character 

sequence over the Main Link. 

Aux Phy Wake 

 

Puts the ALPM sink in the Standby state by writing a bit sequence 

over the Aux Channel. 
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The example below demonstrates the Set DPCD Sleep event being activated 

 

Fast Link Training – Monitoring the ALPM Transactions on the Aux Channel 

Refer to the ACA section Monitoring the DisplayPort auxiliary channels with the ACA utilities for 

procedures in monitoring the eDP ALPM Aux Channel transactions associated with the eDP negotiations. A 

sample screen shot is shown below. 

 

  

  

  

file:///C:/Users/cburt1/Documents/M42d/M41d_Video_Analyzer_Generator_UserGuide_RevA2.docx%23_Monitoring_the_DisplayPort
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 Alternate Scrambler Seed 

The DP 2.0 eDP-capable module supports the alternate scrambler seed. Currently the feature is supported 

only through the command line. Use the following procedures to activate the alternate scrambler seed for an 

eDP source. 

1. Access the command line interface through the ATP GUI Manager console or a terminal program such 

as PUTTY as shown below. 

 

2. Enter qd for the login. 

3. Enter qd for the password.  
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The following screen appears. 

 

4. To enable alternate scrambler, type the following command: 
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5. To disable alternate scrambler, type the following command: 

 

  



M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 250  July 18, 2021 

 

 Backlight Control 

This section describes backlight control and provides procedures for using the M41d HBR3 Video 

Analyzer/Generator to control the backlight of an eDP TCON panel subsystem. 

There are two methods of controlling the backlight: 1) Aux control messages, 2) control backlight thought 

direct connection leads. 

Backlight Control Test Connections 

This subsection provides procedures on how to connect the M42d 80G Video Analyzer/Generator to your 

eDP display panel for backlight control. You will use the Standard DisplayPort connector and the eDP 

header pin block and a special Teledyne LeCroy provided cable assembly. 

1. Connect the provided cable from the eDP System Panel using the eDP connector. 

2. Connect the other end with the standard DP connector and the eDP header block the provided cable to 

the M42d. Refer to the diagrams below. 

Note: The eDP header block is used for controlling the backlight of an eDP display. The pinout and functions are shown 

below. 

eDP Pin Configurations: 

1. BL_Enable (Possible Future Rx input) 
2. BL_Enable (Tx Output) 
3. BL_PWM_DIM (Possible Future RX input) 
4. BL_PWM_DIM (TX Output) 
5. Ground 
6. Ground 

 

 

 

eDP Sink Test Connections 
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Backlight Control – Sink Tests 

Use the following procedure to test eDP backlight on an eDP sink device. 

1. Access the Backlight controls from the Generator panel and the Tools tab. Refer to the screen below. 

 

The following table describes the Tx Backlight Controls. 

Tx Backlight Control Fields 

  

Use Capabilities – Enables or disables the Backlight 

control feature.  

 

Control Mode – Select how the backlight is 

controlled. Options available are: 

▪ Disabled -  

▪ Controlled by DPCD 

▪ Controlled by PWM eDP Pin 

▪ PWM Duty-Cycle x DPCD Set 

▪ DPCD Frequency Set 

 

Brightness – Set the brightness of the backlight. 

 

Note: Must be in Controlled by DPCD mode 
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Tx Backlight Control Fields 

 

PWM Duty Cycle – The Duty Cycle control can be 

modified in percentages from 0 to 100%. The 

percentage of the Duty Cycle controls the percentage 

of the voltage high period. 

 

Pre-Scaling Freq Divider – The Pre-Scaling 

Frequency Divider is used to pre-scale the backlight 

PWM Cycle frequency. 

 

PWM Generator Divider Pn - The PWM Generator 

Divider is used to create backlight dimming PWM 

signal. 
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Appendices 

Appendix A. Licenses 

Many of the features of the M42d require a specific license to operate. This appendix will demonstrate how 

to apply a license, as well as list the available licenses.  

To obtain a license for the M42d, contact Teledyne Support, accessible at 

http://quantumdata.com/support.html  

Applying Licenses 

To apply a license: 

1. Upload the license file (.lic) using the Navigator by clicking Instruments, then selecting Licenses and 

clicking Apply ATP License. Alternatively, you can access this by selecting the Other tab on the GUI 

home screen and selecting Apply ATP License. Both are shown below. 

Note: As the license file will likely be saved to your PC, it is recommended to use the remote host ATP 

Manager for this function. All screenshots are based on this GUI, though they are both similar. 

Using the Navigator: 

 

  

http://quantumdata.com/support.html
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Using the GUI: 

 

2. A file explorer will appear, as shown below. Navigate to the correct directory of the previously 

downloaded license, select the .lic file, and click Open. 

 

3. A confirmation will appear, and you must reboot the device for the changes to take effect. 
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Verifying Current Licenses 

Use the following procedure to check the licenses that are currently applied to your M42d instrument. 

4. Using either the embedded M42d GUI or Remote Host PC ATP Manager, open the Navigator. 

5. Select the Instruments tab. 

6. Choose the instrument that you are looking up and select Information on the left-hand side bar. 

The Remote ATP Manager will automatically connect to the specified device, if not already connected.  
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The About window will appear, which has various information about the device, and has the Licensed 

Features listed toward the bottom of the report, as demonstrated below. 
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Additionally, you can save this instrument information report as a .txt file. This is necessary when contacting 

Teledyne support regarding licenses, as they will ask you to send the report for a number of reasons, 

including: 

▪ The instrument information report includes the hash codes necessary to write a new license for your 

specific instrument. 

▪ The new license overwrites the current license; the new license is appended to a list of the current 

licenses on the instrument, which Teledyne support can obtain from the instrument information 

report. 

Save the Instrument Information Report by selecting the SAVE TO FILE button at the bottom left of the 

report window, as shown below. 

   



M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 258  July 18, 2021 

 

License Listing 

This appendix provides a listing of all licenses available for the M42d.  

The licenses and this listing are subject to revisions. Check current licenses and product ordering codes at 

https://www.quantumdata.com/m42d.html under the Options tab, shown below. 

 

To obtain a license, contact Teledyne Support, accessible at http://quantumdata.com/support.html. 

 

Part Number 
(SKU) 

Description License Keys 

00-00259 quantumdata M42d DisplayPort 2.0 UHBR-20 Video 
Analyzer/Generator                                   

21:33:50:51:68:69:110:111 

  - Base DP 2.0 functionality includes UHBR video generation, 
basic analysis and ACA                  

  

  - With both DP and USB-C ports enabled                                                                 

00-00261 quantumdata M42d DisplayPort 2.0 HBR3 Video 
Analyzer/Generator                                      

21:33:50:51:68:69 

  - Base DP 1.4 functionality includes HBR3 video generation, basic 
analysis and ACA                  

  

  - With both DP and USB-C ports enabled                                                                 

Options   

95-00221 M42d Upgrade 00-00261 to enable UHBR rates                                                          103 

  - Requires 00-00261                                                                                   

95-00222 M42d Passive Probing Main Link and Aux Channel                                                      104 

  - Requires 00-00259 or 00-00261                                                                       

95-00225 M42d DP Enhanced Sink Functional Tests                                                              56:101:105:112:107 

  - Includes DSC (for DP 1.4), LTTPR (and Panel Replay if 00-00259 
or 95-00221)                       

  

  - LTTPR and Panel Replay will be available in a future release                                         

95-00226 M42d DP Enhanced Source Functional Tests                                                            32:55:102:106:108:113:109 

 

https://www.quantumdata.com/m42d.html
http://quantumdata.com/support.html
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  - Includes Capture Analysis, DSC (for DP 1.4), LTTPR (and Panel 
Replay if 00-00259 or 95-00221)     

  

  - LTTPR and Panel Replay will be available in a future release                                         

95-00227 M41d/M42d DP EDID/DisplayID Sink Compliance Test Suite                                              73 

  - Requires (00-00259 or 00-00261) and 95-00225, Or:                                                   

  - Requires 00-00260 and 95-00220                                                                       

95-00228 M41d/M42d DP EDID/DisplayID Source Compliance Test Suite                                             76 

  - Requires (00-00259 or 00-00261) and 95-00226, Or:                                                   

  - Requires 00-00260 and 95-00219                                                                       

95-00209 M4 Series Rackmount Kit                                                                             N/A 

  - Requires 00-00258 or 00-00259 or 00-00260 or 00-00261                                               

95-00212 M41d/M42d Embedded DisplayPort (eDP) option                                                         70 

  - Requires 00-00259 or 00-00261, Or:                                                                  

  - Requires 00-00260                                                                                    

95-00213 M41d/M42d DP 1.4 Link Layer & FEC Source Compliance Test 
Suite                                      

35:48:93 

  - Requires (00-00259 or 00-00261) and 95-00226, Or:                                                   

  - Requires 00-00260 and 95-00219                                                                       

95-00214 M41d/M42d DP HDCP 2.3 Source Compliance Test Suite                                                  33:43 

  - Requires (00-00259 or 00-00261) and 95-00226, Or:                                                   

  - Requires 00-00260 and 95-00219                                                                       

95-00215 M41d/M42d DP 1.4 DSC & FEC Source Compliance Test Suite                                             71 

  - Requires (00-00259 or 00-00261) and 95-00226, Or:                                                   

  - Requires 00-00260 and 95-00219                                                                       

95-00216 M41d/M42d DP 1.4 Link Layer & FEC Sink Compliance Test 
Suite                                        

47:61:94 

  - Requires (00-00259 or 00-00261) and 95-00225, Or:                                                   

  - Requires 00-00260 and 95-00220                                                                       

95-00217 M41d/M42d DP HDCP 2.3 Sink Compliance Test Suite                                                    33:43 

  - Requires (00-00259 or 00-00261) and 95-00225, Or:                                                   

  - Requires 00-00260 and 95-00220                                                                       

95-00218 M41d/M42d DP 1.4 DSC & FEC Sink Compliance Test Suite                                               72 

  - Requires (00-00259 or 00-00261) and 95-00225, Or:                                                   

  - Requires 00-00260 and 95-00220                                                                       

95-00232 M41d/M42d DP 2.0 Link Layer Source Compliance Test Suite                                               115 

  - Requires (00-00259 or 00-00261) and 95-00226, Or:                                                   

  - Requires 00-00260 and 95-00219                                                                       

95-00233 M41d/M42d DP 2.0 Link Layer Sink Compliance Test Suite                                               116 

  - Requires (00-00259 or 00-00261) and 95-00225, Or:                                                   

  - Requires 00-00260 and 95-00220                                                                       

95-00234 M41d/M42d DP Adaptive Sync Source Compliance Test Suite                                               117 

  - Requires (00-00259 or 00-00261) and 95-00226, Or:                                                   

  - Requires 00-00260 and 95-00219                                                                       
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95-00235 M41d/M42d DP Adaptive Sync Sink Compliance Test Suite                                               118 

  - Requires (00-00259 or 00-00261) and 95-00225, Or:                                                   

  - Requires 00-00260 and 95-00220                                                                       
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Appendix B. Configurable LTTPR Capability Registers 

As covered in Chapter 8 LTTPR Testing, while emulating LTTPR for testing of a source, many LTTPR 

capability registers within the DPCD are modifiable. This appendix lists those registers that can be edited. 

Note: For more information on the registers, including field values, see the VESA DisplayPort 2.0 Standard 

document.  

See 8.2 Modifying DPCD of Emulated LTTPR for specific instructions on accessing the DPCD Editor, 

saving custom configurations, and opening them upon startup. A screenshot of the LTTPR tab of the DPCD 

editor is below. 

 

 

LTTPR Capability Registers:  

See the following table for the configurable registers. 

DPCD 
Address 

Register Field(s) 

F0000h  LTTPR_FIELD_DATA_STRUCTURE_REV ▪ Minor Revision Number 

▪ Major Revision Number 

F0001h 8b/10b_MAX_LINK_RATE_PHY_REPEATER MAX_LINK_RATE (Gbps per lane) 

F0002h  PHY_REPEATER_CNT Count: Indicates the number of LTTPRs that 

are present. Up to eight LTTPRs are 

supported. 

F0003h  PHY_REPEATER_MODE Mode: Indicates the mode in which an 

LTTPR is operating. 

F0004h MAX_LANE_COUNT_PHY_REPEATER ▪ MAX_LANE_COUNT 

▪ Reserved 

F0005h PHY_REPEATER_EXTENDED_WAKE_ 

TIMEOUT 

▪ EXTENDED_WAKE_TIMEOUT_ 

REQUEST 

▪ EXTENDED_WAKE_TIMEOUT_GRANT 

F0006h MAIN_LINK_CHANNEL_CODING_PHY_ 

REPEATER 

▪ 128b/132b SUPPORTED 

▪ Reserved  
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DPCD 
Address 

Register Field(s) 

F0007h PHY_REPEATER_128B/132B_RATES ▪ 10 Gbps/lane Support 

▪ 13.5 Gbps/lane Support 

▪ 20 Gbps/lane Support 

▪ Reserved 

 

The following tables are the configurable registers for each individual LTTPR. The only significant changes 

among the tables are the register address for each LTTPR. 

LTTPR1 

DPCD 
Address 

Register Field(s) 

F0020h TRAINING_AUX_RD_INTERVAL_PHY_ 

REPEATER1 
▪ Interval 

▪ EXT_RX_CAP_FIELD_PRESENT 

F0021h TRANSMITTER_CAPABILITY_PHY_ 

REPEATER1 

▪ VOLTAGE_SWING_LEVEL_3_ 

SUPPORTED 

▪ PRE_EMPHASIS_LEVEL_3_ SUPPORTED 

▪ Reserved 

F003Dh IEEE_OUI  

F0040h Device Identification String  

F0046h Hardware Revision ▪ Hardware Major Revision 

▪ Hardware Minor Revision 

F0047h- 

F0048h 

Firmware/Software Revision ▪ Major Revision 

▪ Minor Revision 

 

LTTPR2 

DPCD 
Address 

Register Field(s) 

F0070h TRAINING_AUX_RD_INTERVAL_PHY_ 

REPEATER2 
▪ Interval 

▪ EXT_RX_CAP_FIELD_PRESENT 

F0071h TRANSMITTER_CAPABILITY_PHY_ 

REPEATER2 

▪ VOLTAGE_SWING_LEVEL_3_ 

SUPPORTED 

▪ PRE_EMPHASIS_LEVEL_3_ SUPPORTED 
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DPCD 
Address 

Register Field(s) 

▪ Reserved 

F008Dh IEEE_OUI  

F0090h Device Identification String  

F0096h Hardware Revision ▪ Hardware Major Revision 

▪ Hardware Minor Revision 

F0097h- 

F0098h 

Firmware/Software Revision ▪ Major Revision 

▪ Minor Revision 

 

LTTPR3 

DPCD 
Address 

Register Field(s) 

F00C0h TRAINING_AUX_RD_INTERVAL_PHY_ 

REPEATER3 
▪ Interval 

▪ EXT_RX_CAP_FIELD_PRESENT 

F00C1h TRANSMITTER_CAPABILITY_PHY_ 

REPEATER3 

▪ VOLTAGE_SWING_LEVEL_3_ 

SUPPORTED 

▪ PRE_EMPHASIS_LEVEL_3_ SUPPORTED 

▪ Reserved 

F00DDh IEEE_OUI  

F00E0h Device Identification String  

F00E6h Hardware Revision ▪ Hardware Major Revision 

▪ Hardware Minor Revision 

F00E7h- 

F00E8h 

Firmware/Software Revision ▪ Major Revision 

▪ Minor Revision 

 

LTTPR4 

DPCD 
Address 

Register Field(s) 

F0110h TRAINING_AUX_RD_INTERVAL_PHY_ 

REPEATER1 
▪ Interval 

▪ EXT_RX_CAP_FIELD_PRESENT 



M42d Video Analyzer/Generator - User Guide   Ver. A1 

Page 264  July 18, 2021 

 

DPCD 
Address 

Register Field(s) 

F0111h TRANSMITTER_CAPABILITY_PHY_ 

REPEATER1 

▪ VOLTAGE_SWING_LEVEL_3_ 

SUPPORTED 

▪ PRE_EMPHASIS_LEVEL_3_ SUPPORTED 

▪ Reserved 

F012Dh IEEE_OUI  

F0130h Device Identification String  

F0136h Hardware Revision ▪ Hardware Major Revision 

▪ Hardware Minor Revision 

F0137h- 

F0138h 

Firmware/Software Revision ▪ Major Revision 

▪ Minor Revision 

 

LTTPR5 

DPCD 
Address 

Register Field(s) 

F0160h TRAINING_AUX_RD_INTERVAL_PHY_ 

REPEATER1 
▪ Interval 

▪ EXT_RX_CAP_FIELD_PRESENT 

F0161h TRANSMITTER_CAPABILITY_PHY_ 

REPEATER1 

▪ VOLTAGE_SWING_LEVEL_3_ 

SUPPORTED 

▪ PRE_EMPHASIS_LEVEL_3_ SUPPORTED 

▪ Reserved 

F017Dh IEEE_OUI  

F0180h Device Identification String  

F0186h Hardware Revision ▪ Hardware Major Revision 

▪ Hardware Minor Revision 

F0187h- 

F0188h 

Firmware/Software Revision ▪ Major Revision 

▪ Minor Revision 
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LTTPR6 

DPCD 
Address 

Register Field(s) 

F01B0h TRAINING_AUX_RD_INTERVAL_PHY_ 

REPEATER1 
▪ Interval 

▪ EXT_RX_CAP_FIELD_PRESENT 

F01B1h TRANSMITTER_CAPABILITY_PHY_ 

REPEATER1 

▪ VOLTAGE_SWING_LEVEL_3_ 

SUPPORTED 

▪ PRE_EMPHASIS_LEVEL_3_ SUPPORTED 

▪ Reserved 

F01CDh IEEE_OUI  

F01D0h Device Identification String  

F01D6h Hardware Revision ▪ Hardware Major Revision 

▪ Hardware Minor Revision 

F01D7h- 

F01D8h 

Firmware/Software Revision ▪ Major Revision 

▪ Minor Revision 

 

LTTPR7 

DPCD 
Address 

Register Field(s) 

F0200h TRAINING_AUX_RD_INTERVAL_PHY_ 

REPEATER1 
▪ Interval 

▪ EXT_RX_CAP_FIELD_PRESENT 

F0201h TRANSMITTER_CAPABILITY_PHY_ 

REPEATER1 

▪ VOLTAGE_SWING_LEVEL_3_ 

SUPPORTED 

▪ PRE_EMPHASIS_LEVEL_3_ SUPPORTED 

▪ Reserved 

F021Dh IEEE_OUI  

F0220h Device Identification String  

F0226h Hardware Revision ▪ Hardware Major Revision 

▪ Hardware Minor Revision 

F0227h- 

F0228h 

Firmware/Software Revision ▪ Major Revision 

▪ Minor Revision 
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LTTPR8 

DPCD 
Address 

Register Field(s) 

F0250h TRAINING_AUX_RD_INTERVAL_PHY_ 

REPEATER1 
▪ Interval 

▪ EXT_RX_CAP_FIELD_PRESENT 

F0251h TRANSMITTER_CAPABILITY_PHY_ 

REPEATER1 

▪ VOLTAGE_SWING_LEVEL_3_ 

SUPPORTED 

▪ PRE_EMPHASIS_LEVEL_3_ SUPPORTED 

▪ Reserved 

F026Dh IEEE_OUI  

F0270h Device Identification String  

F0276h Hardware Revision ▪ Hardware Major Revision 

▪ Hardware Minor Revision 

F0277h- 

F0278h 

Firmware/Software Revision ▪ Major Revision 

▪ Minor Revision 

 


